INTRODUCTION

LumaFusion is the first professional
multitrack video editing and effects
app for iOS. LumaFusion was first
published to the Apple App Store in
December of 2016, and our team is
dedicated to continued support and
development. This guide provides a
detailed reference of the features
and capabilities of LumaFusion. We
are excited to welcome you to

Luma FUSion LumaFusion!

—The LumaTouch Team

v2.4 Reference Guide
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1. Using this Guide

This guide should serve as a reference for those wanting to dig deeper into the workings of the
LumaFusion app. Throughout the guide you'll find links to corresponding video tutorials to help you
get the most out of using LumaFusion.

Gesture: Blue indicates there are related gestures you can choose to use.

Tips and Tricks: Purple indicates special information about the best way to use the app or an
alternative workflow that you may find useful.

Video Tutorials: Orange indicates there are one or more corresponding video tutorials for the
topic. For example, below is the link to this chapter’s corresponding video tutorial. Links to
tutorials are green and underlined:

1.1 Getting the Most From The Video Tutorials
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https://youtu.be/GmKFPpI67ZM

2. What's New in the V2.4 Reference Guide

e LumaFusion now supports Wide Gamut (HDR) video processing. While we have supported
import and use of HDR media since iOS 13, now LumaFusion will provide full HDR
output with 10-bit video compression on compatible devices:

Setting the Project Color Space

e LumaFusion now exports H265 with Transparency. Export complex animations that you can
easily overlay in new projects:

Video Codec

e Enjoy a greatly improved Chroma Keyer and Luma Keyer with automatic key detection, mask
display, erosion control, edge blur, and spill suppression.

Chroma Key and Luma Key

¢ Read new descriptions for Frame.io workflows in LumaFusion:
Previewing and Commenting on Frame.io Source Media and
Using a Proxy Workflow with Frame.io, LumaFusion and
Frame.io - Uploading your Timeline and Receiving Comments

e Learn about support for iOS 14 Limited access to Photos App media:
Getting Started

e Learn about an option to use the first clip dropped to the Timeline to set the Frame Rate,
Aspect and Color Space:

Creating a New Project

Setting the Project Frame Rate

Choosing the Project Frame Aspect Ratio
Setting the Project Color Space

e View a log of completed exports:
Information Panel
o Find the projects where a clip is used:
Finding the Projects Where a Clip is Used
e Go to the Frame and Fit Editor under Crop to find the new Invert crop option:

Crop, Corner Radius and Soft Edge
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3. Getting Started

Projects can be created in integer and non-integer frame rates from 18 to 240 frames per

second (fps) and aspect ratios including 16:9, 1:1, 9:16, and a variety of other aspect ratios including
wide-screen film aspect ratios, and aspect ratios for screen recordings and App Preview videos for
different iOS devices. Check out luma-touch.com/support to find articles with the latest
recommendations on settings for creating App Store Previews.

When LumaFusion is first installed, iOS will ask permission to access some or all of the media
in your Photos App. Under iOS 14, if you have chosen limited access (either on installing or
updating LumaFusion, or via Settings > Privacy > Photos > LumaFusion), these selections will be
respected in LumaFusion.

With limited access (selected photos only), the Moments and Albums folders will not appear in the
Library, nor will Shared Albums and Synced Albums if you have these set up.

Once you make your selection, you'll see the empty Project Manager with a message to create a
new project:

&8

Photos

1

All Photos and Videos 614 items

Videos

0J

Moments 146 items

@

Albums

&)

Recently Added 23 items

5
-

Media Types 6 items
Q =

Press + to create your first project

Figure 3-1 LumaFusion — Starting your first project
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https://luma-touch.com/support

Creating a New Project

1. Tap on the Create Project button at the
bottom of the Project Manager. A popup will

X New Project

appear letting you name the project and set My project (12)

the initial aspect ratio, frame rate and color

space. Framerate Based on first video clip added
By default, LumaFusion bases these Frame Aspect  Based on first video clip added
parameters on the first video clip added to the

Timeline. You can set your own preferred Color Space Based on first video clip added
default in Settings >Preferences by turning
OFF Adjust Based on First Video Clip Added. figure 3-2 New Project Panel

2. Tap on each setting to override the defaults and adjust to your desired Frame Rate, Frame
aspect and Color Space.

3. Tap on the Create Project button on the panel to create the project. The project manager will
close so you can begin editing.

Setting the Project Frame Rate

By default, LumaFusion matches the frame rate of the first clip you place on the timeline. You can
change this default in Help and Settings > Preferences>New Project Defaults. First turn OFF
Adjust Based on First Video Clip Added, and then set the Frame Rate default.

Regardless of your default setting the frame rate can be changed for your current project at any
time prior to export:

o Tap the Help and Settings button {':?} and then tap on the Settings tab.

o Tap Frame Rate and adjust the dial to select your preferred fps.

LumaFusion keeps an internal count of all the frame rates of your clips and displays the necessary

frames for the frame rate you set. Changing the frame rate is nondestructive, as all your original
frames are maintained and will be used if your project frame rate or export frame rate requires them.

If you change the frame rate of a project, LumaFusion will duplicate the project leaving your original
project in-tact with the old frame rate. This is because some indivisible frame rate changes may
cause the cut points to be calculated slightly differently.

It is always best to match the frame rate of the majority of your source clips when choosing a
project frame rate. If you shoot at 30fps, and set your project to 60fps, then you won'’t be gaining
any quality. Every frame will have to be displayed twice in order to make up 60fps, essentially
resulting in a 30fps result with twice the data.
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Choosing the Project Frame Aspect Ratio

By default, LumaFusion matches the Frame Aspect of the first clip you place on the timeline. You
can change this default in Help and Settings > Preferences>New Project Defaults. First turn OFF
Adjust Based on First Video Clip Added, and then set the Frame Aspect default.

Regardless of your default setting the Frame Aspect can be changed for your current project at any
time prior to export:

e Tap the Help and Settings button %ﬁ:? and then tap on the Settings tab.

e Tap Frame Aspect and adjust the dial to select your preferred ratio.

There are several things to consider when choosing your Frame Aspect Ratio. The most important
consideration is where your final movie will be displayed or posted. Some social media sites will only

accept certain aspect ratios. Check your destination requirements before setting your aspect ratio.
Setting the Project Color Space

If you change your aspect ratio after editing, graphics and titles may have to be repositioned to
make sure they are both visible and aesthetic in your new aspect ratio.

When source clips have a different aspect ratio than your project, you will need to make a
choice about how each clip is displayed in the space. This is called the Fit Mode.

For 360° projects, you must set the project aspect ratio to 2:1.

For more information, see Fit Mode

Creating and Exporting 360° VR

Setting the Project Color Space

With iOS 14.1 and above on compatible devices, you gain access to the colorful world of 10-bit HDR
workflows in LumaFusion. 10-bit color processing means your image pipeline has over a billion
colors to work with, compared with around 16 million colors in an 8-bit scheme. This can result in
cleaner, brighter, more vivid images with fewer banding artifacts, with lighter whites and darker
blacks for your videos.

This feature requires

e iOS 14.1 or above

e AniPhone or iPad with an A10 Fusion processor or greater
e iPhone 7 or later

e iPad 6th generation (2018) or later
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e iPad Air 3rd generation or later
e iPad Pro 2nd generation (10.5”) or later
e iPod Touch 7th generation (2019) or later

By default, LumaFusion matches the Color Space of the first clip you place on the timeline. You can
change this default in Help and Settings > Preferences>New Project Defaults. First turn OFF
Adjust Based on First Video Clip Added, and then set the Color Space default.

Regardless of your default setting the Color Space can be changed for your current project at any
time in the Settings but will not show up as an Export Option if your project is set to Standard - Rec.
709.

e Tap the Help and Settings button %:'E} and then tap on the Settings tab.

o Tap Frame Aspect and adjust the dial to select your preferred ratio.

Videos produced in a particular color space will carry that color space info on export (including to
Final Cut Pro via FCPXML export) and will provide full HDR playback on compatible devices and
platforms.

o Standard - Rec. 709 (8-bit or 10-bit): The default color space in LumaFusion is also the default
for most video cameras, as well as being the standard dynamic range color space for HDTV
projects, including HD cable, Blu-ray discs and most streaming video today.

e Wide Gamut HDR-HLG: This option is used to create an HDR movie with the Rec. 2020 color
space and HLG transfer function (Rec. 2100 standard). HLG, or Hybrid Log-Gamma, was
developed by the BBC and NHK broadcasting networks and is compatible with older SDR
televisions. For most users, HLG provides the widest compatibility with output displays. Check that
your browser supports HLG for HDR playback.

e Wide Gamut HDR10 (PQ): This option is used to create an HDR movie with the Rec. 2020 color
space and PQ transfer function (Rec.2100 standard). PQ is used when mastering for playback on
specific playback monitors.

e Wide Gamut HDR - P3 D65 HLG: This is the color space used by the iPad and is included primarily
for users who need to master HDR videos specifically for playback on the latest iOS devices and
Mac computers.

Corresponding Video Tutorials:

3-1 Your First Project: Creating & Project Settings in LumaFusion

3-2 Your First Project: Global Settings and Preferences in LumaFusion
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https://youtu.be/7LVrmib0epU
https://youtu.be/o-Ppr1smAKk

4. Managing Projects

The Project List

The Project Manager provides a list of all of your projects, giving you options to create new projects,
import projects, duplicate, consolidate and optimize, and delete projects.

+
Open and close the Project Manager by tapping on the Project Manager button. \é'

o A

® Transitions Original

: : w a
A e

Music Video Send this project to the manager by tomorrow 1:53.09 60 fps 16:9 10/30/20, 4:47 PM (12/12/19)

I T . e

Travel Review this next month 2:0118 24 fps 16:9 10/30/20, 4:20 PM (8/27/20)

H M B B @

Figure 4-1 Project Manager and Project Filmstrips

Project Filmstrip

Each project in the list includes a filmstrip that gives you a quick idea of the project’s contents as well
as information about the project, some of which can be changed.

o Tap anywhere on the project’s filmstrip or data to select a project.
e Tap a second time on a project to open the project.

e Tap the play button |> under the Preview to play a project

e Tap the Info button @ under the Preview to see information about the project.

Gesture:

You can tap on a project and slide your finger along the filmstrip to quickly scrub through the
selected project. You can also use the normal Preview buttons to play and Preview the project
without closing the project manager.
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Add a Project

+
1. Open the Project Manager by tapping on the Project Manager button. \é'

2. Tap on the Create Project button to create a new project.
A popup will appear asking you to name the project and select the Aspect Ratio, Frame Rate, and
Color Space (the current project settings can be changed at any time in Help and Settings {j?} under

the Settings tab, and you can change the default values for these in the Preferences tab).

3. Tap the Create Project button on the panel to create the project and begin editing (the
Project Manager will close automatically).

Color Tag a Project

¢ In the Project Manager tap on the Color Tag button ® located to the left of the project name, to
open the color tag popover. You can later search or sort by color tag, helping you to organize
your projects.

Rename a Project

o Tap on the name of the project in the Project Manager to edit the project's name, OR

e Tap on the Info button @ and then on the Project name to rename it.

Add Notes to a Project

e Tap on the Notes button @ to edit notes for the project. Tap outside of the Notes popover to
close it, OR

e With no clips selected on the Timeline, Tap on the Info button @ and then on the Notes

Remember if you don’t have a keyboard connected, you can use the microphone button located on
the on-screen keyboard to quickly dictate your notes.

Duplicate Project

¢ In the Project Manager. tap on the Duplicate button to create a duplicate copy of the currently
selected project. The new project will be named automatically with a sequential number at the
end.
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Search Project Info

e Tap the Search button Q to open the search bar and keyboard.

As soon as you begin to type into the search field, the project list will be filtered, showing only those
projects that match the text you've entered. Search will accept the project name, data in the notes,
the frames-per-second, and aspect ratio.

You can even search by color tag using the English name of the color; Purple, Blue, Green, Yellow,
Orange or Red. Tapping the search button again will close the search tool and clear the current
search filter.

Sort Projects

Tapping the Sort button ﬁ pops up a list of fields you can sort by.
e Tap on any field to sort by that field.

e Tap on ‘Ascending’ or ‘Descending’ to change the sort order.

o Tap the Close button or tap outside the popover to close it.

Limited metadata is available for media stored in the cloud, such as Photos App media that has not
been cached in LumaFusion.

Delete Project

e Tap on the Delete button to delete the selected project. You will be asked to verify whether
you want to delete the project.

Media is independent from the project and must be deleted separately if desired. If you have
accidentally deleted a project, you can restore it by accessing the automatic project data backup.

For more information on automatic backups, see Automatic Project Data Backup
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Archiving, Restoring and Consolidating

Optimize and Consolidate Project

Optimize and Consolidate resolves most performance and sync issues that can arise in the event
that LumaFusion does not receive reliable file data from outside the app. This option assures that all
media in your project is encoded in an iOS compatible format at the highest possible quality that
your device supports.

Consolidate Only without optimizing can be useful in order to ensure the portions of the media used
in your consolidated project are located in the LumaFusion directory and not inadvertently removed
from your device by an external action (including deletion to save space).

In both cases, your original project remains unchanged with the original media.

Both Optimize and Consolidate and Consolidate Only will create a duplicate project with the text
“Opt” or “Cons” appended. The media for the duplicated project will be copied into the Imported
folder in your LumaFusion Library and can be found in the LumaFusion > UserMedia folder in the
Files App.

e Tap on the Optimize and Consolidate button.

e Choose either Optimize and Consolidate or Consolidate Only.

Corresponding Video Tutorial:

4-1 Managing Projects: Duplicating, Deleting, Optimizing & Consolidating Projects in LumaFusion

Export (Archive) LumaFusion Project Package

1. Tap once on the project in the Project Manager to select it.

2. Tap on the Export button. m
3. Choose LumaFusion Project Package from the pop-up list.

4. Select a destination. If you don’t see the destination you are looking for, tap Add/Edit
Destinations.

For more information, see Add/Edit Export Destinations

5. Choose Full Original Media or Trimmed Media.

6. Name your project export if desired and tap the Export button m on the panel.

For more information, see Exporting a LumaFusion Project Package

¢é: Lumalouch



https://youtu.be/sJfzH7vQJE4

Tips and Tricks: Creating a LumaFusion Project Package creates an “archive” of the project and
the media referenced by the project. The Package (.Ifpackage) can be saved to cloud storage,
AirDropped to your Mac desktop, or sent to another app such as the Files App.

The projects can be restored again using the Project Import button M in the Project Manager.
Note: To import video, audio and photo media, use the import button at the top of the Library
instead of the Import button in the Project Manager.

Corresponding Video Tutorial:

4-2 Managing Projects: Archiving, Restoring and Recovering Projects in LumaFusion

Import (Unarchive) a LumaFusion Project Package

1. Tap on the Project Import button &I in the Project Manager to import projects you’ve previously
saved as LumaFusion Project Packages.

2. Navigate to the directory where you've stored your LumaFusion Project Package, logging into a
cloud service or external drive if necessary and browse or search to find the .Ifpackage file you
want to import.

3. If you don’t see the source you are looking for tap the Add/Edit Import Sources button.

For more information, see Add/Edit Import Sources

4. Tap the Import button m

The imported project will be added to the project list. If there is already a project with the same
name, the newly added project name will be appended with a number.

Automatic Project Data Backup

Multiple backups of your project are saved automatically (data only, no media). You can find the
backups in the Files App under On My iPad (or On My iPhone) > LumaFusion > Project Backups.

To open a backup, tap on it in the Files App and it will open in LumaFusion with an appended
number after the name. You can set the number of backups stored, in the Preferences tab of the

Help and Settings menu %:91} .
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https://youtu.be/BQhaGe1PUOw

5. The Media Library

Library Sources

The Library shows media and content that can be added to your project. Sources
In addition to media in the Photos App, you can also import media from a
variety of cloud storage options, some types of wireless connected drives
and USB-C drives, or access media in the Storyblocks for LumaFusion 5] Files
royalty-free Library.

52 Photos

] Imported

Tap on the source button % in the top left to select a new source for the
media Library.

(8) Storyblocks

When you switch between sources, LumaFusion will keep track of your I Tites

last location within each source to make it easy to quickly find and work %] Transitions

with your media. '
(+) Add/Edit Sources

Figure 5-1 Library Sources

5-1 Media Library: Sources; Photos, Videos, Music, Titles, Transitions, Storyblocks in LumaFusion

Add/Edit Library Sources . Edit Sources

Available In-Use

You can add, remove and organize your Library
Sources. Limiting the source list to the items you
use will help you stay focused and work faster.

WD Photos

® &

w)  GNARBOX Storyblocks

J  Music Imported

To add, remove or reorder a source:

Files

= O OO

Titles

1. Tap on the Add/Edit Sources button @

Transitions

N

2. Touch and hold on the handle buttons ~ to
drag the sources between the Available
column and the In-Use column. Items in the
In-Use column will appear in LumaFusion in
the order shown.

 Frame.io

3. Move the items up or down in the list to Figure 5-2 Adding and Organizing Library Sources
reorder. You can pick up multiple items by
tapping and holding on one item, and then tapping on an additional item with another finger.

4. Tap the back button in the upper left of the panel to exit.
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https://youtu.be/U6_uxw7Juyo

Photos

The Photos tab % displays content from the f—
Photos App. When you start LumaFusion the first '
time, the Library will show the various folders from
the Photos app, starting with All Photos and
Videos.

All Photos and Videos 614 items

Videos 451 items

Moments 146 items

When LumaFusion is first installed, iOS will ask
permission to access some or all of the media in
your Photos app. Under iOS 14, if you have

Albums 15 items

chosen limited access (either on installing or Recently Added 23items
updating LumaFusion, or via Settings > Privacy >

Photos > LumaFusion), these selections will be B el fpes Sims
respected in LumaFusion. Q &

With limited access (selected photos only), the
Moments and Albums folders will not appear in
the Library, nor will Shared Albums and Synced Albums if you have these set up.

Figure 5-3 Photos App — Content organization

If you have chosen limited access and want to select media, tap the Action Menu button @ at top
right in the Library, you’ll see an option to ‘Select Photos Media for LumaFusion.” Tap this option to
refine your Photos app privacy settings.

As you add, remove, edit or move items into Albums inside the Photos App, the LumaFusion Library
will be updated. To force an update, pull down on the Library window to refresh.

If you have edited any of your assets while in the Photos app, those current versions will be
displayed whenever possible. LumaFusion will provide the original unedited file when there is
an image with transparency (such as a .png file with an alpha channel) or when there is a slow-
motion video clip.

LumaFusion makes a copy of media you use from the Photos app so that if the original media is
deleted from the Photos app it will still exist on your device for your project. LumaFusion will
automatically remove its copy of the media when it’s no longer in use in a project.

For more information about Automatic Cleanup, see
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Optimize iOS iPad/iPhone Storage

When you have Optimize iPad (or iPhone) Storage turned ON in your
iOS device’s Settings App (Settings/Photos/iCloud Photo Library) some of
your full resolution video is stored in iCloud to save space on your device.
In the Photos App you can view proxies of the media stored on iCloud, %
but only when you tap the “Edit” button in the Photos App will the media 18.29 1920x1080
download. In LumaFusion you will see a cloud icon on the photo or video.

Figure 5-4 Media in iCloud
In LumaFusion when you drag a clip stored in iCloud to the

Timeline, LumaFusion will download the full-resolution photo or

stripes on your Timeline clip until download completes and _

video while you continue to work. You will see blue and green

“Downloading Media” with a progress wheel in the upper right of Figure 5-5 Timeline Media needs
the Timeline. This process will be almost instantaneous with caching
photos as long as you have an internet connection.

Corresponding Video Tutorial:

5-4 Media Library: Optimized Photos Storage on iOS and Automated Media Management in
LumaFusion

Storyblocks

Under the Storyblocks tab @ you'll find:

e Contents from the Storyblocks for LumafFusion royalty-free stock footage and music Library
including Backgrounds, Footage, Music and Sound FX. (Requires internet connection and
subscription for the full library — some items are provided for free.)

e Storyblocks clips that have already been downloaded in a Cached Media folder

For more information, see Storyblocks for LumaFusion

Titles

Under the Titles T tab you'll find:
e Standard Title templates included with LumaFusion
e Any titles that you've created and saved as Title Presets in the Title Editor

For more information about Titles, see Title Editor
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https://youtu.be/QDtFxKyRrVg
https://youtu.be/QDtFxKyRrVg

Transitions

The Transitions tab E/J'[j includes a variety of transitions to add before, after and between clips on
your Timeline.

For more information about Transitions, see Transitions

Corresponding Video Tutorial: 12-3 J-Cuts and L-Cuts in LumaFusion

Music

The Music tab cﬁ includes:

o All unprotected media in the Music App that has been downloaded to your iPhone or iPad using
the Music App

Frame.io

By integrating with Frame.io LumaTouch has eliminated the need to exit the LumaFusion App to
review and respond to comments, mark in and out points on source media, and share and receive
comments on versions of your projects with disparate teams and clients.

There are several ways you can utilize Frame.io to improve collaboration opportunities in
LumaFusion.

e See and respond to comments on source media stored in Frame.io,

o Upload your project as a video to Frame.io and receive and respond to comments made in
Frame.io on your project right from the LumaFusion Timeline.

o Edit with automatically generated proxies for media that is not compatible with iOS such as
ProRes, then relink to the original ProRes Media in Final Cut X using the export to FCPXML
feature.

e Use Frame.io as a place to share LumaFusion project packages with other LumaFusion
editors for continued editing. Any Frame.io comments will be saved with the project.

For more information about using Frame.io in LumaFusion, see:
Previewing and Commenting on Frame.io Source Media and
Using a Proxy Workflow with Frame.io, LumaFusion and

Frame.io - Uploading your Timeline and Receiving Comments

Imported

The Imported tab E includes media imported directly into LumaFusion from cloud storage (such as
Box, Dropbox, Google Drive, or OneDrive), media imported via Share to/Open In (from another app),
media added manually to the LumaFusion/UserMedia folder in the Files App, and Voiceover or
Rendered Movie media created inside the LumaFusion app.

For more information, see Import
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https://youtu.be/UCZLibxqJbE

Files

The Files tab @ provides access to external drives, network drives (SMB), and folders from any
other apps that have a shared folder of media (such as FiLMiC Pro).

1. Select the Files Tab

2. Tap on Add Link to Folder to show the iOS folder selection.

3. Select any external drive,
network drive, or folder on a
drive or in another app
displayed in the folder O onwmyipad
selection. Choose to link to [@ Affinity Photo
the folder where the media
resides, rather than directly to
the media or a folder higher in
the tree, which will cause you original

to have to navigate folders in
LumaFusion to find media. Figure 5-6 Linking to FiLMiC Pro Media from the LumaFusion Library

Cancel E=® Done

Access will be granted to “original” on On My iPad.

| FiLMIC Pro

srm

4. Tap Done. Now you'll be able
to browse, preview and trim the media in the linked folders right from the LumaFusion library.
Any new clips added to those folders in the Files app will show up automatically in LumaFusion.

Note: You can use the Files app in iOS to setup network drive (SMB) connections that can then
be linked to in LumaFusion.

5. To remove a linked folder in the LumaFusion Library, press and hold on the drive name in the
LumaFusion library. A menu will appear with an option to Remove the link (this will not remove
any media already cached).

If you try to access a linked folder for a drive that is not currently connected, LumaFusion will display
a message. In this case, simply connect the drive, wait a few moments for iOS to recognize it, and
then pull-down in the LumaFusion library to refresh the contents.

Only when you add clips to the Timeline will LumaFusion make a copy of the file into the
LumaFusion app. These copied files will appear in the Cached Media folder in the Files tab.

The Cleanup tab in Help and Settings of LumaFusion gives you options to remove this cached
media automatically or when you want. You can also select individual media files in the Cached
Media folder to delete them if not in use in any projects.

For more information, see Cleanup
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e Add a link to the FILMiC Pro app folder, and you’ll be able to directly browse and access
media you’ve captured in FILMiC without having to copy files or save them to the Photos

app.

e You can use external drives on iPhones and iPads with Lightning connectors by using the
USB adaptor. You will need to connect separate power to the extra lightning connector on
the USB adaptor for the drive to work properly.

GNARBOX

The GNARBOX tab shows media on a connected GNARBOX drive. LumaTouch has partnered
with GNARBOX, the creators of Network Attached Storage (NAS) drives to provide a seamless
experience for previewing, importing and exporting media for editing within LumaFusion.

1. Connect your GNARBOX drive to your device as required by the manufacturer.

2. Tap on the Library Source button % and then select GNARBOX from the list.

In the Library, you will see thumbnails of the media located on the drive. You will be able to preview
the media inside LumaFusion without importing it first.

3. Tap on the clip in the Library.
4. Mark In and Out points in the Preview window (if desired).
5. Drag the clip to the Timeline.

Unique to GNARBOX, once the clip is on the Timeline, LumaFusion will begin to import only the
portion added to the Timeline, and you will see a progress message. The import will happen as a
background process and you can continue to preview and add clips to the Timeline while import
continues.

If the GNARBOX drive is not connected you will see a warning at the top of the Library. You will still
see any previously cached media and will be able to continue to edit with this media.

You may also import full files from GNARBOX, see SMB Network Attached Storage Drives
For more information on GNARBOX go to https://www.GNARBOX.com
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https://www.gnarbox.com/

Western Digital WD My Passport Wireless Pro, SSD and MyCloud

(The WD tab won't display unless a WD My Passport Wireless Pro, WD My Passport Wireless SSD,
or MyCloud Drive is, or was previously, connected.)

The WD tab shows media on a connected WD My Passport Wireless Pro, WD My Passport
Wireless SSD drive, or MyCloud drive. LumaTouch has partnered with Western Digital to provide a
seamless experience for Previewing, importing and exporting media for editing within LumaFusion.

1. Connect your WD My Passport Wireless Pro or WD My Passport Wireless SSD drive to your
device as required by the manufacturer.

2. Tap on the Library Source button % and then select WD from the list.

In the Library, you will see thumbnails of the media located on the drive. You will be able to Preview
the media inside of LumaFusion without importing it first.

3. Tap on the clip in the Library.

4. Mark In and Out points in the Preview window (if desired).
5. Drag the clip to the Timeline.
6

Once the clip is on the Timeline, LumaFusion will begin to import the entire source clip for any
frames added to the Timeline, and you will see a progress message. The import will happen as a
background process and you can continue to Preview and add clips to the Timeline while import
continues.

If the WD drive is not connected you will see a warning at the top of the Library. You will be able to
view and use any previously imported media.

You may also use Import to add files from WD, see SMB Network Attached Storage Drives

For more information on WD Portable Drives, go to www.wdc.com
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https://www.wdc.com/products/portable-storage.html

Adding Clips to the Timeline

If the Play head is at the end of the Main Track, when you insert a clip, the play head will update to
the end of the added clip, so you can quickly insert multiple clips in a row to your Timeline.

e Press and hold for a moment on any media item in the Library to begin dragging it. You can then
drag it to any track on the Timeline, OR

e Tap once on a clip to view it in the Preview, and then Press and hold on the Preview image to
drag the marked portion to the Timeline, OR

e Double tap an item in the Library to quickly add it to the Main Track of the Timeline at the current
play head location. Any photos, videos or titles will be added to the Main Track, while audio clips
will be added to whichever audio track has ‘room’ for it at the current time, OR

e Tap once on a clip in the Library to view it in the Preview, and then tap on the Send to Timeline

button .:.J}: under the Preview. Devices without enough screen space will not display this option.

Multi-Select Library Clips

When a clip is selected in the Library, the Multi-Select button @ is available.

1. Tap on the multi-select button to highlight it, then select additional clips from the Library either by
single tapping on each one, or by dragging your finger left and right over the rows starting with
an unselected clip (dragging to select is disabled on the iPhone in portrait mode).

2. Each selected item will have a number
showing its selection order. This is the order in
which they will be added to the Timeline.

Imported «Travel-1

3. Tap to remove a clip from the selection or
change its selection order.

4. Press and hold on any of the selected items to
drag all items to the Timeline (or double tap
any selected item to quickly insert all selected
items at the play head on the Main Track).

5. Tap on the Select All button @ to select all
clips in the current Library view.

Corresponding Video Tutorial: Figure 5-7 Multiselected Clips

5-2 Media Library: Adding One or Multiple Clips to the Timeline, Marking In & Out, Deleting
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https://youtu.be/Z6fQmX23AX8

Timeline Warnings

LumaFusion supports all files that are supported by iOS and your device type. To see a complete list
of files that are supported by your device view the technical specifications for your device. For
example: https://www.apple.com/ipad-pro/specs/

LumaFusion also allows import from external sources such as cloud storage, USB-C drives and
wireless drives. Because of this, it is possible to import media that is not on Apple’s list of supported
files. These unsupported files could potentially cause the App to crash, or the playback to be jumpy.
However, in many cases it may still be possible to successfully edit and export your movie with
unsupported files on the Timeline.

If your files are not supported by iOS, LumaFusion receives a warning from iOS, and it will be
displayed on the Timeline whenever an unsupported clip is selected. It is recommended to use this
information to make decisions about how to proceed with your project. You will also see a warning

symbol A at the start of the clip.

This clip is no s i0S
device and m back issues.

A 1812 P1066608.mp4

Figure 5-8 Incompatible media warning

If you have Timeline warnings, and you are experiencing difficulty with playback or export, use the
Optimize and Consolidate feature to ensure your media is compatible.

For more information on Optimize and Consolidate, see Optimize and Consolidate Project
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Finding Your Media

Library Breadcrumb

The Breadcrumb shows your location within the T 2 e e e
selected source. If there is not enough room to . i,
display the entire location, just the current
folder/group will be shown.

e Tap on the category to view its contents (in
figure 5-5, the folder button). The breadcrumb
at the top of the Library will change to show
your new location.

e Tap on the last text in the breadcrumb to go
back one level or tap on any segment in the
breadcrumb to back to that specific level.

Figure 5-9 Breadcrumb at the top of the Library for
navigating to directories

View and Sort

The View and Sort button ~ = controls how the items in the Library are displayed. The button
dynamically displays the current sort type and direction, so the button will look different depending
on your current Sort settings.

o Tap one of the three View buttons to select
how you want to view items in the Library,
Auto, List or Thumbnails. Auto will switch View
between list and thumbnail view automatically
depending on your current location.

View and Sort

View Type

Sort
e Tap the sort field to choose the criteria for

sorting the contents of the current Library. Field Created Date

e Tap Ascending or Descending to change the Direction Descending
direction of the sort.

Figure 5-10 View and Sort Panel

Note: View and Sort function is dependent upon metadata shared by the Source. Some sources
(such as Photos and Storyblocks) provide limited metadata with previews.
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Search

The Search tool allows you to find media based on the clip name, data in the notes, the frames-per-
second, and aspect ratio. You can even search by color tag using the name of the color (Purple,
Blue, Green, Yellow, Orange and Red). You can write your search term using an Apple Pencil as
well.

o Tap the Search button Q, to open the search bar and keyboard.

As soon as you begin to type into the search field,
the clips will be filtered, showing only those clips Imperiee O

that match the text you've entered.

Figure 5-11 Library search bar

The activity indicator next to the magnifying glass indicates whether the search is still working.

To the right of the active Search bar you will see
the Search Scope. Here you can change where Al
LumaFusion is searching. Normally it will search [E—
in the current Library source. You can change to
‘All’ to search all Library sources.

Figure 5-12 Scope of search

To close the search page:
o Tap the delete text button (or delete all text from the search bar).
o Tap the breadcrumb to return to the page you started the search from.

e Tap the Search button again.

Color Tag Clip

e Tap on the Tag clip button @ to tag a clip or multiple selected clips with a color. Tagging can be
very useful for organizing your media (for example, tag all interviews with green and b-roll video
purple). The color you choose will be shown in the Library as well as the Timeline for that clip.

Tips and Tricks: You can select a Timeline clip and open the Info Panel @ to change the color
tag of the Timeline clip even if it has previously been tagged with a color in the Library.

Corresponding Video Tutorial:

5-3 Media Library: Viewing, Sorting, Searching, Color Tagging & Notes
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https://youtu.be/X6kw-xgx228

6. Storyblocks for LumaFusion

Requires internet connection

Content of Storyblocks for LumaFusion

Under the Storyblocks tab in the Library @ youll B SEREEE
find: Footage

Contents from the online Storyblocks royalty-free
stock footage and music Library including

Backgrounds

Music

e Footage

e Backgrounds Sound FX

® MUSIC Audio Collections 12 items
e Sound FX

Video Collections 12 items

e Audio Collections
Cached Media 6 items

¢ Video Collections

Clips, if any, that have already been downloaded Figure 6-1 Storyblocks categories
are located in a Cached Media folder. Once clips
are cached there, they are available without an internet connection.

Even without a subscription there are dozens of

royalty-free media clips available in the ) SiEyleeieiblele
LumaFusion App for your use. These items are EEp AT nEp 100
marked as “Free” in the Library and are presented

at the top of each category. 2201000 2421000

Figure 6-2 Free Storyblocks Content
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Storyblocks for LumaFusion Subscription

Hundreds of thousands of Storyblocks video, music, background and sound effects clips can be
Previewed without a subscription and are available for use in your LumaFusion projects with either a
monthly or yearly Storyblocks for LumaFusion subscription. With this subscription the media will be
available for download and use in any of your LumaFusion projects. The media is royalty-free for any
type of production, including personal or commercial use.

To start a subscription:

1. Drag any piece of Storyblocks media (that is not labeled as “Free”) to the Timeline, or double tap
on the media in the Library to add it to the Timeline. A pop-up panel will appear.

2. Choose the subscription model that fits your needs. On this panel you can also view the
Storyblocks for LumaFusion Terms of Use.

3. Sign in with your Apple User ID to complete the purchase.

4. If you have already purchased Storyblocks for LumaFusion in some cases, you may have to tap
Restore Purchases on the purchase panel to reinitialize your subscription.

It is not possible to transfer subscriptions made directly with Storyblocks to the LumaFusion App
or visa versa.

How to Cancel Your Storyblocks Subscription

To cancel a subscription:

1. Atleast one day before the end of your subscription, open your device’s Settings App.
Tap on your Apple ID.

Go to Subscriptions.

Tap on LumaFusion — Storyblocks for LumaFusion.

o > w0 b

Tap on Cancel Subscription for the subscription that is check-marked as active.

Note: After your subscription ends, you may still continue to use any footage or music you have
already cached into LumaFusion until the footage is deleted from the device. At that time, the media
will no longer be available unless it is saved and restored as part of a project backup.

Important: If you delete the LumaFusion App, you must still cancel the subscription in your
device’s Settings app to avoid automatic renewal of Storyblocks. This subscribe/unsubscribe
functionality is managed by the App Store.
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Using Tags and Search with Storyblocks

After selecting one of the categories (Backgrounds, Footage, Music, or Sound FX) a set of ‘Tags’ will
appear at the bottom of the Library. The available tags are dependent on the category selected.

For example, if you select the Sound FX category you will see tags such as Alarms, Animals,
Applause, Bangs and Bells etc. If you select the Footage category you will see tags such as 360,
Aerial, Animals, Beverages, Business etc.

e Tap on a tag to filter the current Library Q Sound FX «Search (Sound FX)
contents. Running On Dirt Path ¢
. . 3.00 PS
e Tap on additional tags to further filter the ‘
contents. In this example, both Footsteps and e .
Glass are selected so the Sound FX displayed : P
. Running Barefoot - Indoor
are clips that have both Footsteps and Glass 2300 -
either in the name, or in the metadata of the Forest Running “
C|Ip 16.00 S
Running Through Stony Corridor ¢
e Use the Search Q button to narrow the 1200 C
search further. In the example above, we've '
added ‘Running’ . Running] Sound FX &

¢ When finding Storyblocks Music there are
three types of tag that can be applied; Genre,
and Mood. Combine a variety of
tags to narrow down the results to the music you want find.

Figure 6-3 Using searching and filtering together

e Tap on the Reset Tags button [ at the left of the row of tags to
stop filtering by tags.

All

Storyblocks
o Use the Search Scope popup to determine whether to search within
the current category, All of Storyblocks, or All of your LumaFusion Seue] X
Library.

Figure 6-4 Search Scope
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View and Sort Options for Storyblocks

-6
Tap on the View and Sort button =0 display
options for Storyblocks. With so much media in

View and Sort

the Storyblocks Library, the Display option is a e

quick way to filter the results of your Search View Type s

and/or applied Tags based on characteristics like

Most Relevant, Most Downloaded, Highest Rated, Sl

Most Recent, Trending Now and Undiscovered. Field Storyblocks Display

If the filter is not applied to the Library contents
immediately, you can pull down on the Library
window to refresh. Storyblocks

Direction

Display Most Relevant

Talent, Property and Editorial Use

When using video media with identifiable ECISRE R 2 2

individuals or landmarks, or public scenes that
include names, people, trademarks, logos,
uniforms, registered or copyrighted designs or
works of art, be sure to enable the Property
Released and/or Talent Released check marks in Is Editorial (Videos)
the Storyblocks View and Sort settings.

4K Only (Videos)

Property Released (Videos)

Figure 6-5 View and Sort Options for Storyblocks
Some images may be used for editorial purposes
only (NOT commercial or advertising purposes).
These images can be found by checking Is Editorial.

o Typically, editorial media may be used in magazines or newspaper articles, blogs, or websites
for informational purposes only, for non-commercial presentations.

o Editorial media may not be used in any kind of advertising or promotional material.

It is important to consult with your own legal advisor and review your license agreement to make
sure that you have secured all necessary rights, consents or permissions as may be required
for use of any media you present.

For more information, see: https://luma-touch.com/sb-terms-of-use/

6-1 Storyblocks for LumaFusion: Royalty Free Backgrounds, Footage, Music and Sound FX
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7. Import

Media can be imported from a variety of cloud storage sources including iCloud Drive, Dropbox, Box,
Google Drive and OneDrive. Media can also be imported from wireless/network drives that use the
SMB protocol, supported GNARBOX and Western Digital drives, SanDisk iXpand Flash Drives, and
USB-C connected drives.

Importing Media

1. Tap the Action Menu button @ at top right in Import Media Sources
the Library to reveal, then tap the Import import Media
Media button [V .

2. Choose the source where your media is
located. A popup will appear with a list of
cloud storage providers that you can import
media from as well as any Wireless/Network
SMB drives you have available. OneDrive

Dropbox

Google Drive

3. If you don'’t see the source you are looking for,

tap on the Add/Edit Sources button @

. . Add/Edit Sources
For more information, see

If you haven’t logged in to this storage
provider before, you’ll be guided through the
login. This login is performed securely on the
provider's website. LumaFusion never receives your user ID and password; we only store a
temporary token when you authorize the use of LumaFusion with your provider.

Figure 7-1 Import Sources

/I\
To log out, tap the Log Out button O

C € T
4. After logging in, you'll see a list of files and - O

folders for that provider. Files that cannot be
imported will be disabled. Depending on the Figure 7-2 Space Available and Log Out button
provider, certain attributes, such as resolution,

duration and file size will be listed.

410.87 GB available Terri Morgan (Luma Touch)

5. Use the Search Q button to quickly find media for import.

=d
6. Tap on the View and Sort button == to change the way the results are displayed. When sorting
cloud services, it may take a moment for the sorting to update. Pull down on the window to
refresh.

7. Tap on a media item to select it for import (it will change color to indicate that it is selected). Tap
a second time to deselect a media file.
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8. Continue selecting media (even in different folders, or from different providers) to be imported.
You can return to a previous folder by tapping on the breadcrumb list at the top of the popup.
Tap on ‘Sources’ in the breadcrumb to return to the original list of source providers that you can
import from.

9. When you are ready to import the selected media, tap on the Import button [V atthe top right of
the popup.

LumaFusion will begin importing the selected media. This can take some time depending on the size
of files being imported and the speed of your connection. When the import is complete, LumaFusion
will show the last imported file in the Album. Imported media in LumaFusion will be organized by
provider name (i.e.: Dropbox, Box, etc.) and the parent folder from that provider.

Import Sources

Add/Edit Import Sources

You can add, remove and organize your Import
Sources. Limiting the source list to the items you

Edit Sources

Available

use will help you stay focused and work faster. SanbiskiXpand Box

=] Wireless/Network Dri... 53 Dropbox
To add, remove or reorder a source:

2 Google Photos (A Google Drive
1. Tap on the Add/Edit Sources button @ & OneDrive

2. Touch and hold on the handle buttons  to ] Files
drag the sources between the Available
column and the In-Use column. Items in the
In-Use column will appear in LumaFusion in
the order shown.

3. Touch and hold on the handle buttons to move
the items up or down in the list to reorder. Figure 7-3 Add/Edit Import Sources

You can pick up multiple items by tapping and
holding on one item, and then tapping on an additional item with another finger.

4. Tap the back button in the upper left of the panel to exit.

Files App and USB-C Connected Drives

Although you can use media on connected USB-C drives in the Files App directly from the
LumaFusion Library, you can also use the Files App as a traditional Import Source. The benefit of
importing media into LumaFusion in this way is that you can then disconnect the drive after importing
and the media will be available for use.

See also, see.
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SMB Network Attached Storage Drives

Server Message Block (SMB) Protocol is a network file sharing protocol. External drives using the
SMB Protocol will work as a source to import from directly into LumaFusion without first adding the
media files to the Photos or Files app on your device. If you have an SMB drive attached, it will show
under Wireless/Network Drives.

If your drive requires a login and you haven’t logged in to this drive before, you'll be guided through
the login.

ll\
To log out, tap the Log Out button O

After logging in, you'll see a list of files on the 410,87 GB available
drive. Files that cannot be imported will be
disabled. Depending on the drive, certain
attributes, such as resolution, duration and file size
will be listed.

Figure 7-4 Space Available and Log Out button

You can remove a network drive by pressing-and-holding on the network drive’s name. An option to
remove the drive will appear.

Import Media Sources

SanDisk iXpand Flash Drives

You can import directly from (and export to) an
iXpand Flash Drive or an iXpand Flash Drive
Go. If the SanDisk iXpand Flash Drive is #2|  SanDisk iExpand
connected to your iOS device, it will show up on —
the list of Import Sources in LumaFusion. 1 Wirelece/Netwnrk Drives

Figure 7-5 Import Sources — SanDisk iExpand

‘Share to’
LumaFusion appears as a Share extension, so
it's easier to get media in from other apps (like Save to Files 5
Affinity Photo). When the file in the other app is

. . . . Save to Dropbox 3}
compatible, LumaFusion will appear as an option
to share to. In the Other App share sheet, tap on Share to LumaFusion

LumaFusion, and the media will be imported and
will appear in the Library. LumaFusion organizes
imported media from other apps in the Imported
folder organized by the name of the app that
shared the file.

Edit Actions...

Figure 7-6 Open in LumaFusion
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Import Content in Zip Files

LumaFusion supports importing zip files containing media, title, color and effect presets, fonts, and
LUTs (color Look Up Tables), making it easy to create a standard set of content to share with others,
ensuring your brand or style is consistent between editors. Upon import, the files will be unzipped
and added to the appropriate places within the app.

Managing Your Media

H H ee st Whoosh ivers Watch Bi og barking in green sc...
Used Media Indicator prep sty o
W AT
L . o : X
e Avyellow line is shown at the bottom clip in the v P ' 5
Library_ The |ength and position of the line 126 480 KHz Stereo  29.28 1920x1080 16:9  14.03 1920x1080 16:9
indicates the portion(s) used on the current
Timeline Figure 7-7 Orange lines indicate used portions of the clip

¢ A white checkmark indicates the media is used in the currently open project.

e A black checkmark indicates the media is used in another project.

Tips and Tricks: A white checkmark on a clip in the Library indicates the clip is used in the
current project. A black checkmark on a clip indicates the clip is used in a different project.

Delete Imported Clips

If the selected clip was imported directly to LumaFusion (not a clip from the Photos App), and is not
in use within any project, you'll be able to delete the clip.

o Tap the Trashcan button @ under the Library to delete the selected file in LumaFusion.

Where Photos App Media is Stored During Use

To ensure your projects always have media available, in LumaFusion 2.0 and beyond, when a clip
from the Photos App is used in a LumaFusion Timeline, LumaFusion will make a copy of the media
and store it in the Files App in: Files App > On My iPad (or iPhone) > LumafFusion > LibraryMedia >
PhotoLibrary. Now, even if the file is removed from the Photos App or iCloud your LumaFusion
project will still have the media necessary to fill your project Timeline.

When the media is no longer used in LumaFusion (in any project), by default, the LumaFusion
cached copy of the media will be deleted automatically but your Photos App version will remain. This
cleanup process is invisible and automatic. You can control whether the media cache is deleted
when the media is not in use, in the Cleanup section of the Help and Settings menu.

To learn more about media cleanup see,
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Adding (and Removing) Media using a Desktop Application

LumaFusion stores imported media in subfolders of the Documents/UserMedia folder. You can use
the Files app, or a utility on your Mac or PC such as iMazing or iExplorer to easily copy files to and
from LumaFusion, as well as create folders to organize media in any way you would like. Be careful
about deleting, moving or renaming files that are used by projects. If you do so, the projects will
show missing media. We recommended you rely more heavily on the Cleanup functions within
LumaFusion unless you are comfortable with iOS media management.

For more information, see.
Corresponding Video Tutorial:

7-1 Import: Add Media from Cloud, Connected Devices, Zip Archives, iOS & Desktop Apps

Relinking and Replacing Missing Media

LumaFusion makes a copy of media you use from the Photos app and stores it in a cache so that if
the media is deleted from the Photos app it will still exist on your device for your project. LumaFusion
will automatically remove its copy of the media when it's no longer in use in a project. And
LumaFusion will not allow you to delete media from the Library if it's in use in a project. With these
two safeguards it is unlikely you will experience missing media.

However, it is still possible for you to remove the LumaFusion copy of the media either by using the
Files app, or by explicitly removing used media in Help and Settings > Cleanup. If the LumaFusion
copy is deleted, LumaFusion will automatically try and reimport the original media from the Photos
app as soon as you open a project (the clips will appear with green stripes while LumaFusion is
importing the media).

If LumaFusion is unable to find the original media (due to it being deleted from Photos, or if Photos
has been re-synced causing the index numbers to be reassigned), then you will see clips with red
stripes, indicating that the media is missing.

53.04

Figure 7-8 Missing media
LumaFusion will offer to try to find missing media automatically. If the automatic relinking doesn’t
work, you'll need to relink media manually.

e The first thing to do is try to retrace your steps and undelete the media, reimport it to the app or
put it back into the Photos App. Then restart LumaFusion and it will attempt to relink it.

¢ [f the automatic relinking doesn’t succeed, drag the reimported clip over the Timeline clip that
has missing media. Choose the option to Replace Missing Media from the pop-up message.
This will maintain the original trim points in the clip.

Corresponding Video Tutorial:

7-2 Import and Media Management: Cleanup, Relinking and Replacing Missing Media
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https://youtu.be/V_0SwOo6BOU
https://youtu.be/cyAZNE8mtbY

8. The Preview

Source videos, photos, audio, titles, transitions, graphics and projects can be played in the Preview.
When you single-tap on a media item in the Library it will be highlighted, and the Preview will show
that media. Or if you tap on your project Timeline, the Preview will show your project.

3.21 [5.03]

[«..t ,.Tww&g,wn-wwr]

L K > M ]

Figure 8-1 Source Preview with Mark In and Out brackets Figure 8-2 Timeline Preview with Navigator

Transport Controls

Jump Backward

e Tap the Jump Back button [KI to jump to the previous Mark, Marker, or the start of the clip.

e Double tap the Jump Back button to jump (past any Markers and In and Out points) directly to
the start of the clip, or to the start of the Timeline.

e Press and hold Jump Back button to begin single-frame stepping backward.

Jump Forward

e Tap the Jump Forward button [>|] to jump to the next Mark, Marker, or the end of the clip.

e Double tap the Jump Forward button to jump (past any Markers and In and Out points) directly to
the end of the clip, or to the end of the Timeline.

e Press and hold the Jump Forward button to begin single-frame stepping forward.

Play/Pause/Loop Play
e Tap Play |> to begin playback, tap Pause HU to pause playback.

(—D
o Double-Tap the Play button to initiate Loop-play <1MJ between the In-point and the Out-point on
a source or begin loop-play of the Timeline. Tap again to stop loop-play.
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Incremental Scrubber

Press and hold the Play button |> to open the incremental scrubber to move slowly through your
media.

The farther you move left or right, the faster the scrubbing — forward to the right and backward to
the left.

The blue time counter at the right shows how many seconds and frames you have moved the
cursor since the scrubber was activated.

312 (19.27) 611 (19.27)

it Wit e T

N g) e P L \\__]

[ ]| +1fes | ] [ ] ] | #istes

Figure 8-3 Incremental Scrubber showing 1 fps frame advance and 15 fps frame advance

Timeline Navigator

Tap on the Timeline to show an overview of your project.

Tap anywhere on the navigator to instantly move the Timeline to that portion of your project.

Slide your finger across the navigator to quickly scrub through your project.

@
o0L
006

Figure 8-4 Timeline Navigator
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Preview Timecodes

At the bottom of the Preview there are two timecodes displayed. Note that time is displayed in hours,
minutes, seconds and frames. Less than a minute will only show seconds and frames (0.00), and
less than an hour will only show minutes, seconds and frames (1:00.00).

Current Time

Figure 8-5 Current Time and Duration

The left-hand timecode (white numbers) shows the current time within the clip, this will change as
you move the play head by scrubbing or playing the clip. For example, if you’re clip is 30 frames per
second, the numbers will increment from 0 to 29 for each second of the clip.

Duration

The right-hand (yellow numbers) show the duration between Mark-In and Mark-Out. When you add
the clip to the Timeline, the yellow indicates the duration that will be added.

For more information, see
Corresponding Video Tutorial:

8-1 Preview: Transport Controls, Timeline Navigator and Understanding Timecode in LumaFusion

Pre-Trimming Clips

You can pre-trim a video or audio clip to insert just a portion of the clip to the Timeline. A trimmed
clip is indicated in the Library by yellow brackets with the trimmed duration.

e Tap on a video clip in the Library.

e Drag the orange trim brackets in the filmstrip, or move to a position on the filmstrip, and then tap

on the mark-in [ and mark-out buttons j on the transport bar or swipe up or down in the Preview
to mark in or out.

e Touch, hold and drag from the Preview to the Timeline.

e Drag the orange left-right arrow between the mark-in and mark-out to simultaneously slip-
trim the start time and end time of the marked portion without changing the duration.
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https://youtu.be/hm3d5z9gXM8

Preview Gestures

Single Tap in the Preview to play and pause.

Swipe down or up in the Preview to mark an In-Point or Out-Point.

Double Tap in the Preview to grow the Preview to full-screen. Double tap again to return.
Swipe Left and Right in the Preview to step forward and backward one frame.
Two-Finger Swipe Left/Right in the Preview to select the next and previous item from the
library into the Preview to quickly browse and trim multiple items in the library.

Press, Hold and Drag the image in the Preview to drag the marked portion to the Timeline.

Press and hold the Play button to open the incremental scrubber to move slowly left and right.

Corresponding Video Tutorial:

8-2 The Preview: Gestures, Pre-Trimming Clips, and Marking in LumaFusion

Markers

Markers can be added to source clips or project Timelines and will be displayed in the filmstrip or
Timeline navigator, respectively.

1. With the clip or Timeline in the Preview, navigate to a frame and tap the Marker button @
2. A Notes field will appear allowing you to comment on the marker. You can begin to type right
away, or open this field again later using the Edit button i

o To navigate to a marker, tap on the marker or use the Jump buttons.
e To Color Tag a marker, tap the Color Tag button © and select a color.

o To delete a marker, navigate to the marker and press the Delete Marker button g

Corresponding Video Tutorial:

8-3 Preview: Using Markers in LumaFusion
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https://youtu.be/qRP5E5Y1Bok
https://youtu.be/WrjI204b74M

Using an External Monitor

If you have a video monitor connected to your device either with an HDMI connector or AirPlay, then
you can view a full screen video output of the LumaFusion preview and choose a variety of layouts
designed to let you choose a workspace that best suits your style.

Connecting an External Monitor with an HDMI cable

1. Connect your iOS device to a USB-C Digital Multiport Adaptor, or an Apple Lightning Digital AV
Adaptor, and then connect the adaptor to a video monitor via the HDMI input.

2. On the LumaFusion interface, tap on the External Monitor button @

ool
3. Tap the Layouts button 1 select one of the external display layouts.

Connecting an External Monitor with Apple AirPlay

1. Go to your iOS device Control Panel and turn ON Screen Mirroring.

2. Choose your AirPlay device name. You may have to enable AirPlay on your monitor.

3. On the LumaFusion interface, tap on the External Monitor button @

1]
4. Tap the Layouts button L1 select one of the external display layouts.

Corresponding Video Tutorial:

8-4 Preview: Using an External Monitor over HDMI or AirPlay in LumaFusion

Frame.io

Internet Connection Required

Frame.io is a cloud-based collaboration platform that enables you to stay connected with all your
teams—on videos, images, and more—from anywhere on the planet. The LumaFusion integration
with Frame.io is one of the best there is, allowing you to stay right in LumaFusion to send and
receive comments about your media and your project.
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https://youtu.be/llLgtswTA2U

Previewing and Commenting on Frame.io Source Media

1. When you select Frame.io
from the Library Sources for
the first time, you will be
prompted to Log into your
existing Frame.io account.

2. Inthe LumaFusion library,
navigate to the Frame.io
project and the media you
want to use.

Please darken these areas and add contrast overall

3. Tapon a clip. Play, Mark In
and Mark Out as you normally
do.

‘f\ Will do. Should | push in tighter as we discussed?

4. |If there are Frame.io
comments on the media, you
will see markers in the filmstrip  Figure 8-6 Frame.io comment with graphic annotation
of the preview. Tap on the
marker to view text or graphic annotations that were added in Frame.io.

e Tap the Reply button to type a response.
o Tap the Edit button /to change the text of a comment.
e Tap the Trash button @ to remove a single comment.

+
5. To add a new comment, tap the Frame.io button ))"' on the Preview transport bar and type.
6. To add the marked portion of the Frame.io media to the Timeline, touch, hold and drag it to the

timeline, or send it to the timeline using the Send to Timeline button :@: , or double tap the clip
in the Library as you would any other clip.

Once the clip is on the timeline, the app will begin caching the media in the background and it
will appear in the Cached Media folder in the LumaFusion > Frame.io Library.

For information on cleaning up cached media, see:

Using a Proxy Workflow with Frame.io, LumaFusion and FCPX

One of the outstanding features of Frame.io is that it automatically creates compatible proxies for
editing on iOS. That means you can add ProRes or MXF media to Frame.io and seamlessly edit in
LumaFusion without having to re-encode media in order to make it compatible with iOS.

If your original media is ProRes, once you’re finished with your project in LumaFusion, you can
either export to your final destination with the high res proxy media, or you can export an XML
Project Package with No Relinkable Media to your desktop computer. This latter option will transfer
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the XML file with only media created directly in LumaFusion like titles, but it will leave out the proxy
media.

When you open the XML file in Final Cut Pro X, you can re-link your timeline to the original Pro-Res
media stored on Frame.io.

Under Help and Settings >Preferences you can choose between downloading 4K proxy files, 1080
HD proxy files, or the original file (when possible). If you are unsure whether your media is
compatible, this option will always download the highest resolution proxy when the original clip is
incompatible with iOS.

For information on exporting to FCPXML, see: Export to XML Project Package for FCPX
For information about Frame.io, see Previewing and Commenting on Frame.io Source Media and

Frame.io - Uploading your Timeline and Receiving Comments
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9. Information Panel

The Information Panel is the place to go when you
need to learn more about your clip or project, its
metadata, or media type, and on compatible
devices running iOS 14 or greater, its color space.
In the Information Panel you can also add
metadata to the clip such as a name, notes or a
color tag.

e Tap the Information button @ below the
Preview to display the summary information
for the selected clip or Timeline.

e Tap the More button coo to view extended
metadata including name, frames per second
(fps), duration, aspect ratio, created and
modified dates, how many clips and tracks in
a project, Exif, IPTC and PNG metadata. In
this extended view you can also add notes,
rename clips and projects, and color tag clips
already added to a Timeline.

e For projects, the Info Panel also features a log
of completed Exports, detailing settings, dates
and destinations.

r with b

ment in

ains. Silhouette
ort lifestyle
9.7 MBits/s

Figure 9-1 Summary information of a selected clip on the

Timeline

% Woman traveler with backpack hiking in mountains. Silhouette hiker walking
in the mountains, freedom and happiness, achievement in mountains. Active...

=/ Add Notes

Duration  24.05

Video

Resolution

&

0:00 (24.05)

Disﬁ-ﬁ-ﬁmﬁ»ﬁ»aﬁ»ﬁ»aﬁ##aﬁ######vﬁ#-ﬁ]

(G

Unlinked Tracks 0

Full Package Size 8.

Trimmed Package Si.

Movie Size

10/1/20, 8:04 AM

10/10/20, 8:44 AM

11/10/20, 9:59 AM

D ]

Exports

xtreme, 44.1KHz

, Full media

Figure 9-3 Extended information of a project including export log
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Rename Clips or Projects

¢ In the extended Information Panel tap the Nametag button @ or anywhere on the name to
rename the clip.

Many clips don't initially have names (like those from the Photos App), so this can be useful in
organizing your media inside of LumaFusion. This name will not be saved with the original clip
in the Photos App, but will be searchable within the LumaFusion Libraries.

Add Notes

o Tap the Add Notes button @ to add descriptive information about your clips. These notes are
only used within LumaFusion for searches and reference and are not saved with the original clip.

Color Tag Timeline Clips

e Select a clip on the Timeline and then tap the Color Tag button © to add or change the color of
the clip on the Timeline. Using color tags is a great way to highlight certain areas of your
Timeline, or certain types of clips (i.e. Interviews, b-roll, montage).

Tagging or naming a clip from the Timeline only changes the name or color of that instance of
the clip in the Timeline. It does not affect the clip in the Library. When a new clip is added to the
Timeline from the Library, its notes and color tag are maintained on the Timeline clip, but can
later be changed independently from the Library item.

Finding the Projects Where a Clip is Used

e Select a clip in the Library and then tap the Info button @ Scroll down to see a list of projects
that clip is currently used in. This can be helpful information since clips that are used in any
Project cannot be deleted from LumaFusion.

Corresponding Video Tutorial:

9-1 Info Panel: Clip Metadata, Renaming, Adding Notes and Color Tagging in LumaFusion
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https://youtu.be/hPMe69KNob8

10. Editing Basics

LumaFusion provides an advanced multitrack Timeline that gives you complete control to create
amazing sequences and compositions, while keeping clips on additional tracks in sync with the story
on your main Timeline as you make changes.

9 124 (60 @m‘ 10 1.0 o‘ 1.0 70 ©l#88.04 Edit anywhere you go. @ o3 ©¢205 Ccn
—

I
4 @128 0 0:2." 1.0 98 (70 il © @ 6.07 Aerial footage fro (K240C 10 ©l2.00070 ©/®302 N ©@ 328 Flyinchi0

I
1.0/ @205 @219 Grj 1.0 1.28 P/\1.22.( %8 9.06 Air Bubbles Underwater.mp4 122 [0] @ #  6.08 Photosintt 3.02 Macro PO @®#: 1.0/ 3.01 Divers &

Figure 10-1 LumaFusion Timeline

The Main Track

The Main Track of the Timeline is the first video track you see on
the Timeline and has special control over the other tracks of the
Timeline.

For example, the Insert/Overwrite mode only applies to clips on Main Track
the Main Track. Clips on other video and audio tracks are linked
to the clips on the Main Track by default and are therefore
affected by the Insert mode when clips on the Main Track move,
thus adopting the behavior of the Insert/Overwrite setting.

Figure 10-2 Main Track on Empty

Clips can be unlinked from the main track individually or in bulk. o
Timeline

For more information, see:
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The Ruler

The ruler displays increments of time in hours : minutes : seconds . frames. How much detail you
see on the ruler depends on how far zoomed in or out you are on the Timeline. The shorter white
ticks (seen only when zoomed in) are single frame increments.

| —— | - 1
5. Silhouette hiker walking in the mountains, freedom and happiness, achievement in mountains. Active sport lif  7.12 Back view of young stylish woman standingin fron | @ 7.12 Back view young womal

Figure 10-3 Ruler at the bottom of the Timeline

Timeline Gestures:

Pinch to zoom in and out on the Timeline

Triple Tap to zoom into single frames. Triple tap to go back to your last zoom level.
Double Tap to see your full Timeline. Double tap to zoom back to your last zoom level.

The Play Head

The vertical blue or white line in the middle of the Timeline is the
frame that is currently shown in the Preview. When zoomed out
the line is blue. When zoomed in on the Timeline far enough to
see the distance between the start and end of a single frame, the
ruler will become white and cover a single frame.

Figure 10-4 Play Head zoomed into frame level

Adding Clips

The Play head determines where on the Timeline the clip will be added when adding a clip with
double tap, or the Send to Timeline button .:J}:.
e Press and hold on a media item in the Library, then drag it to the Timeline, OR

e With a source clip loaded in the Preview, press and hold anywhere in the Preview to drag the clip
to the Timeline, OR

e Double tap on the clip in the Library to add it to the Main Track of the Timeline, OR

e With a source clip loaded in the Preview, tap the “Send-to-Timeline” button (only available on
larger screens).
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e Tap the Add Clip button @ to add special clips at the current time.

The available types of clips will depend on whether the Timeline play head is aligned with a cut
or placed anywhere over a clip.

Main Title - Adds a simple title to the Main Track of the Timeline. You can then quickly change

the title using the Presets button or by double tapping on it to open the Title Editor.

Overlay Title - Adds a simple title to the first available overlay track (above the Main Track).

Voiceover - Opens a tool to record a voiceover starting at the current time.

Blank Clip - Adds a blank clip to the Main Track of the Timeline. This is useful in Insert Mode
when you want to leave a gap or add a placeholder to replace with media later.

Transition — Adds a transition to a cut point.

o

o

If the play head is located on a cut point, the Transition option adds a cross dissolve.

If the play head is at the beginning of the Timeline or the beginning of an overlay clip, a
fade-up transition will be added.

If the current time is at the end of the Timeline or end of an overlay clip, a fade-down
transition will be added.

If the play head is within the first half of a selected clip, then a fade-up will be added from
the beginning of the clip to the current time.

If the play head is within the second half of a selected clip, then a fade-down will be
added from the current time to the end of the clip.

Removing Clips

You can remove clips on the Timeline and either leave a blank space in its place or close the gap.
The clips will still remain in the Library.

1. Select a clip on the Timeline by tapping on it.

2. Tap on the Trashcan button @ OR

Drag the clip upwards and let go of it outside the Timeline area.

Insert mode = The resulting gap will be closed, and clips later on the Timeline moved earlier.

Overwrite mode __ No other clips on the Timeline will be moved, and a blank space will remain.
Switching to Insert mode will allow you to trim, extend, replace or remove the blank space.
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Tips and Tricks: Clips linked to a clip that is removed from the Main Track will also be removed.

)
Select the clip on the Main Track, and tap Unlink C" prior to removing the clip if you want the
linked clips on other tracks to remain.

Moving Clips
You can move or reorder clips on the Timeline. The results are dependent on whether the Main

Track is in Insert or Overwrite mode (tap the icon to toggle between Insert and Overwrite modes).

e Move a clip in the Timeline by pressing and holding on the clip until it ‘lifts’ from the Timeline and
then drag it to another position.

Insert mode =/ Clips later on the Timeline will move out of the way to make room for the clip you
are moving, and the resulting gap will be closed.

Overwrite mode _ No other clips on the Timeline will be moved, and the clip you are moving will
overwrite clips where it is dropped.

For more information, see: Insert / Ripple Delete Mode and Overwrite Mode

Tip: If a Main Track clip has linked clips, it can only be dropped into the Main Track again.

Split Clip(s)
Splitting a clip is a fast way to divide a clip in order to remove, trim or replace a section.

e Tap % to split clips at the current time. If no clip is selected, then all clips that can be split at the
current time will be split.

e If you have a clip selected, only that clip will be split. Tapping Split a second time will split all
other tracks at the Play head.

e Split will be disabled if you cannot split any clips at the current time.

Undo/Redo

Undo levels are saved back until the point the project was last opened or the app was last restarted.
e Tap the Undo button < to undo your last actions change-by-change.

e Tap the Redo button A to redo any changes you have Undone.
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Clone Clip

e Tap to make a copy of the selected clip and place it in the Timeline.

If the selected clip is the last clip in the Timeline on its track, then the clone will be placed
immediately after it. Otherwise, the clone will be placed immediately above it on the next available
track. If there is no available track, then the clip will be placed at the end of the selected clip’s track.

Corresponding Video Tutorial:

10-2 Basics: Adding, Removing, Moving and Splitting Clips in LumaFusion
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https://youtu.be/9eMVX26Idog

11. Critical Editing Concepts

LumaFusion provides a powerful editing model that utilizes the best of traditional track-based editing,
plus the best of a magnetic timeline with clip linking.

This chapter talks about how existing clips behave when media is added, removed or reordered;
Insert, Overwrite, Replace and Clip Linking. It's important to understand how these operations
function, in order to predictably manipulate the clips on the Timeline and therefore enjoy the process
of editing.

Edit Modes

Insert / Ripple Delete Mode

When in Insert Mode =] clips on the Main Track are moved out of the way to make room for new
media when adding clips or trimming. Gaps are closed when removing media from the Timeline.

1. Drag a clip from the Library or from another
position on the Timeline and hover it near a 4 4.08_media000006.mpa
cut until you see the yellow Insert symbol,

then drop the clip.

2. Toripple delete, tap the Trashcan button @

or tap on a clip and drag the clip off the Figure 11-1 Preparing to insert a new clip at the yellow
Timeline. Insert symbol

Overwrite Mode

In Overwrite Mode __, any actions taken on the Timeline (like trimming, adding or deleting clips) in
one location on the Timeline will not have an impact on the positioning of clips at another location on
the Timeline.

e Adding clips to the Main Track or trimming will overwrite any existing clips along the time range
of the new clip(s), and there will be no changes to the rest of the Timeline.

o Gaps will be created when media is removed
from the Timeline by deleting a clip or
trimming. When you return to Insert mode,
these gaps will exist as blank clips that can be
trimmed, replaced or removed.

1. Drag a cIip from the Library or from another Figure 11-2 Preparing to place a new clip at the position of
o . . . the white O it bol
position on the Timeline and hover it near a cut ¢ "¢ Pverwrite symbo
until you see the white box Overwrite symbol.

 4.08 media000006.mp4

2. Drop the clip. The portion of the clip under the white box will be overwritten.

3. Atany time, tap the icon to toggle between Insert and Overwrite modes.
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Replace Mode

Replace media without removing the existing clip.

1. Press, hold and drag a clip from the Library or
from another position on the Timeline and

)

. . . © 3.03 015F " 4.08 media000006.mp4
hover it over a clip until you see the yellow 7"

Replace symbol. — )

2. Choose one of the options from the pop-up
menu which describe the possible outcomes Figure 11-3 Clip hovering over clip to be replaced
depending on the length of the source clip and
whether you are in Insert or Overwrite mode.

Corresponding Video Tutorial:

11-1 Critical Concepts: Advanced Editing; Insert, Ripple Delete, Overwrite & Replace in LumaFusion

Clip Linking

Clips added to overlay and audio tracks are linked

to clips on the Main Track (the Main Track has et oM

. . . e ——— |
brlghter CIIpS and a Ilghter gray background). @ 3.02 Macro Close- @ 3.28 Flying Through Dense[ %1.00 C
Links are indicated by a small line from the first |
frame of the linked clip to the adjacent clip on the  FRESEEEREEREEETE AR A EE il Rl Sl
Main Track. :

When you perform edits on the Main Track such
as adding clips, moving clips and deleting clips,
linked clips will shift to stay linked to the clip (and

the specific frame on that clip) where you
positioned the clips originally. Figure 11-4 Timeline with overlay and audio clips linked to

Main Track

Clip Linking is an important feature for properly
timing B-rolls, sound effects, and titles and it frees you from worrying about shifting sync when
making changes to earlier parts of the Timeline.
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https://youtu.be/vul7_DfmwO8

Unlinking and Relinking a Clip or Clips

There may be times when you don’t want clips linked, and instead want them to be positioned at an
absolute time in the Timeline. For example, you might want a music clip placed at a specific time in
your movie so that you can edit visuals to the music.
0
e To unlink the selected clip, tap the Unlink button & .
e You can also unlink all clips linked to a clip on the Main Track by selecting the Main Track clip
and tapping the Unlink button.

D : .
e Youcanrelink U a selected clip at any time.

e If you use the Multiselect button @ to select more than one clip, you can unlink or link multiple
clips at a time.

Tips and Tricks: When you remove a clip on the Main Track that has other clips linked to it,
those linked clips will be removed also.

Unlinking All Clips on a Track

There may be times when you don’t want an entire track of clips linked, and instead want them to be
positioned at an absolute time in the Timeline. For example, you might edit with specific timing for a
voiceover and then want to edit visuals to the voiceover without the voice clips moving when you
move or trim visuals.

)
e To unlink all the clips on a track, tap the Header button [::= and then tap the Unlink button & for
the desired track. New clips added to a track with linking turned off will not be automatically
linked and cannot be linked manually until track linking is turned back on.

Tips and Tricks: To quickly ensure all clips are linked for the entire track, toggle Link Button
from Linked, to Unlinked and back again to Linked.

Corresponding Video Tutorial:

11-2 Critical Concepts: Clip Linking and Unlinking, and Multi Track Editing in LumaFusion
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https://youtu.be/HggsEFyARvM

Timeline Multiselect

Tap on the Multiselect button N and then use one or more of the methods below to select multiple
clips:

e Dragtheln [ and Out] brackets in the
Navigator under the Preview. Any clip whose
first frame sits between the In point and the
Out point brackets will be selected. Double
tap the Navigator to reset to Nothing
Selected. Double tap again to Select All, OR

Figure 11-5 In and Out brackets defining selection in Navigator

e Touch and hold on a blank area of the
timeline, then drag your finger diagonally
across the Timeline to initiate a lasso of clips.
Clips whose first frames are contained within
the lasso will be selected, OR

e Tap each clip to select multiple consecutive
clips on the Main Track, or any (including non-
contiguous) clips on the overlay video or
audio-only tracks.

Figure 11-6 Lasso multiple clips on the Timeline

When multiple clips are selected, information is

displayed at the top of the Timeline including the
beginning point of the selection, the number of - —
clips selected and the duration of the selection. ,

Note the two different background colors on the
timeline — lighter blue for the main track selection
duration and darker for the overall selection Figure 11-7 Multiselect statistics at upper right of Timeline
including overlay and audio tracks.

Clip selections on the main track must be consecutive to provide a predictable outcome when
moving or pasting. If a nonconsecutive clip on the main track is selected to the left or right of the
original selection, all clips between the selected clip on the main track and your new selection
will be added to the multi-select range.

Selection of clips on overlay and audio tracks does not need to be consecutive. When moving
or pasting, clips will maintain their relationship to each other and to any selected clips on the
main track. This may result in a blank clip at the start of your timeline in order to maintain the
relationship.
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Deselecting from a Multiselect
To deselect clips:

o Tap the Multiselect button @ to turn it OFF, OR.

e To deselect a clip from a range of selected clips, tap on any selected clip on the overlay or audio
tracks, or on a selected clip at the beginning or end of the selected range on the main track, OR.

¢ Double tap the center of the selected range on the Navigator to reset the range and deselect all
clips. Double tap again to Select All.

Multiselect Functions
With multiple clips selected you can quickly perform bulk actions on all the clips:

¢ Move: Touch and hold the selected clips, then drag along the timeline just as you would with a
single clip. Release the drag to place the clips.

o Delete: Tap the Delete button Iﬁl or tap the Delete key on your keyboard.

, . D D o
e Link or Unlink: Tap the link U or unlink O clips buttons on the Timeline toolbar.

o Detach Audio: Tap the Detach button , or triple-tap on the selection to detach audio. Audio-
only clips will be generated from any original clip that contained audio and added to the next
available audio track.

e Add Effect Presets: Tap the Clip Presets tool to apply Preset effects. Depending on the
class of clips selected, a range of visual, motion, text and audio presets can be applied. (Effects
that are grayed out cannot be applied the multiple selection.)

e Cut: Tap the Clipboard (=] and tap Cut , or use the Command-X keyboard shortcut.
e Copy: Tap the Clipboard =] and tap Copy , or use the Command-C keyboard shortcut.

o Paste: Tap the Clipboard (=] to Paste @ Cut or Copied Clips and their attributes.
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Clipboard

Cut, Copy and Paste one or more clips, with or without their effect attributes, or copy the attributes of
a clip and apply those attributes to another clip or selection of clips using the Clipboard button =],
The copy/paste information is held temporarily.

Cut / Copy / Paste Clips Clipboard
1. Select one or more ClipS. 1 clips with attributes copied
1 clips selected
2. Tap the Clipboard button ‘=, and the Clipboard panel Paste selected attributes

will appear.

3. Tap the Copy button or Cut button to copy or
cut the clip(s) including any applied attributes to the Replace Color & Effects (@
clipboard.

7

Copy Cut Paste

4. With no clips selected on the timeline, tap the Paste

button @{/ to paste the clip(s) and all effect attributes,
to a new location on the timeline, or into another project.

Figure 11-8 Clipboard with Replace Color and
Effects Turned ON

To Copy/Paste Effect Attributes

1. Select a single clip on the timeline.

2. Tap the Clipboard button =] , and the Clipboard panel will appear.

3. Tap the Copy button or Cut button to copy or cut the clip including any applied
attributes to the clipboard.
4. Select one or more clips on the timeline where you want the attributes to be applied.

5. Select the attributes you would like to paste from the attributes list below:

gy
LQJ Frame & Fit — The position, rotation, size and attributes (including animations)
ﬁ Blending — The opacity (or any applied blend modes) of the clip

(l)) Audio — Includes all audio attributes and audio effects of the clip

0%

%of Color — Includes applied color effects

@ Effects — Includes effects other than color

6. Choose whether or not to Replace Color and Effects. With this toggle turned ON, Effects from
the Color and Effects Editor will be Replaced rather than appended.

7. Tap the Paste button @ to paste the attributes from the copied clip onto the target clip(s).
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Track Header

The track header holds tools that apply certain behaviors to the whole track rather than just a single
clip on a track, or the project as a whole.

== to show or hide the Track Header.

e Tap on the Track Header button

Lock Track &

The Lock Track button l% prohibits actions on the track to avoid the possibility of
accidental modifications. When a track is locked, clips on the track cannot be
added, moved, split, selected, edited, deleted, or trimmed.

Figure 11-9 Track
header controls

In Settings > Preferences you can choose what happens when an audio or overlay track is locked
and the clips are linked to clips on the Main Track, which can still be moved.

¢ Unlink Track When Locked - ON (Default) Clips on the locked track, unlink from clips on the
Main Track when the track is locked. The linking is recalculated when the track is unlocked
again. This mode assures nothing on the locked track will be moved either directly or indirectly
by moving a clip on the Main Track.

¢ Unlink Track When Locked - OFF Audio and overlay clips retain their links to clips on the Main
Track. If clips on the Main Track are moved, then clips on the locked track will also move to obey
the linking settings. This mode ensures that the sync relationships between linked clips are
maintained.

View Track

The View Track button <&> toggles OFF/ON the visual playback for the track. This is useful to
export multiple versions of a project (for example with titles and without), or to view a track without
overlay clips.

Mute Track

The Mute Track button (I)) toggles OFF/ON the audio playback for the track. This is useful to export
multiple versions of a project (for example with music and without), or to listen to a project without a
track of audio.
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12. Trimming Clips

Timeline Trimming

When trimming the beginning or end of any clip on the Timeline, the results are dependent on
whether the Main Track is in Insert or Overwrite mode.

17.04 Autumn Sunset With Tree 2 Air Bubbles Underwater 13.00 Slow Motion Splashing Water

| g

Figure 12-1 Timeline with overlay and audio clips linked to Main Track

1. Select a clip by tapping on it in the Timeline. The clip will become highlighted and the trim
handles will become visible.

2. Drag the leading edge of the clip to trim the head of the clip and drag the trailing edge of the clip
to trim the tail of the clip (you'll see arrows indicating which directions you can trim based on
whether there is media available).

= Clips later on the Timeline will move earlier or later as you trim.

— No other clips on the Timeline will be moved, and the clip you are trimming will overwrite clips
(if trimmed longer) or leave a blank gap (if timmed shorter).

become unlinked if the linked frame on the master clip is trimmed away.

If a main clip is trimmed in Insert mode and has linked clips, the linked clips will attempt to
remain attached to the same frame of the clip. If the linked frame is trimmed away will the link
move to the closest remaining frame.

For more information, see Clip Linking

Corresponding Video Tutorial: 12-1 Trimming Clips on the Timeline in LumaFusion

Slip Trim

e Tap '“" Slip to open the Slip Trimmer for the currently selected clip.

The slip trimmer adjusts the start and ending frame of the clip without affecting the duration of the
clip in the Timeline. Touching the slip timmer closer to the in-point displays the first frame in the
Preview while you trim. Touching closer to the out-point displays the last frame while you trim.

Corresponding Video Tutorial: 12-2 Slip Trimming in LumaFusion
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https://youtu.be/DDPYs9igiVo
https://youtu.be/aIOpbDEbZmU

J-Cut and L-Cut

J-Cuts and L-Cuts, also known as split edits, refer to an editing technique where sync audio starts
before or after the video starts, making a pattern with the clips on the Timeline that looks like a J or
L. This technique is often used when cutting between two interviews to soften the cut, or when
cutting between one scene and another allowing the audio to usher in the second scene.

Audio Priority J or L-Cut

1. In Insert mode = add the two video/audio scenes or interviews to the Timeline and trim them
so the audio sounds exactly as you want it.

2. Triple tap both clips to detach the audio.

3. Enter Overwrite Mode — .

4. Trim the end of the first video clip to the right, or the start of the second clip to the left so the
video cut either follows the audio cut or precedes it.

Figure 12-2 L-Cut with video preceding audio

Video Priority J or L-Cut

1. In Insert mode =>| add the two scenes or interviews to the Timeline and trim them so the video
cut looks exactly as you like.

2. Triple tap both clips to detach the audio.

3. Trim the audio clips so the audio cut either follows the video cut or precedes it.

w ® 3.15 media000006.mp4 *""’-J‘ ' 3.01 media000004.mp:

= cantiilanndl - BN

Figure 12-3 J-Cut with audio preceding video
Corresponding Video Tutorial:

12-3 J-Cuts and L-Cuts in LumaFusion
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https://youtu.be/UCZLibxqJbE

13. Transitions

Transitions are effectively animations that can be
used to introduce, switch between, or have a clip 2.23 media000006.mp4 |10.20 Crdl
enter from or exit to black (fade-in or fade-out).

'@'ﬁ_

For audio clips or audio associated with a video ———{ 020 Cro
clip, any transition will work as a volume fade. If
you do not want the audio of a video+audio clip to
be faded, triple tap the video clip to detach the

audio onto a separate track before or after adding
the transition. Figure 13-1 Crossfade transitions on video and audio clips

0.20_Cra___

o Transitions can be added between two clips (video, photo, title or audio) to create a smooth
animation and volume fade between the first clip (A) and the second clip (B).

e Transitions can be added to the head of a Timeline or overlay clip to animate its appearance or
fade-in the audio.

¢ Transitions can be added to the tail of the Timeline or overlay clip to animate its disappearance
or fade-out the audio.

Tips and Tricks: Transitions from the Library are quick and easy to use, but it is possible to
design and animate your own custom transitions by using two tracks on the Timeline and then
using key-framing in the Frame and Fit Editor or the Color and Effects Editor to transition from
one clip to another.

Adding Transitions

e Drag a transition from the media Library into the Timeline, OR

Tap the Add Clip button @ on the Timeline and select Transition. When the play head is
positioned on a cut point or at the head or tail of the Timeline, the default transition length will be
added. When the play head is within a selected clip then the transition will be added at the nearest
cut and the duration will be determined by the distance from the play head to the nearest cut.
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Positioning Transitions

As a transition is dragged across a cut in the Timeline, a clip will change to show how it will be
added (to the head, tail, or centered between two clips). Notice the purple graphic shows whether it's
a fade or crossfade.

Start at Cut (Fade In)

To animate-in or fade-up, drag the transition so that the indicator
shows it starting at the cut.

Figure 13-2 Transition - start at cut

End at Cut (Fade Out)

To animate-out or fade-down drag the transition so that the A = CETEr
indicator shows it ending at the cut. s

0.20 Cross [

Figure 13-3 Transition - end at cut

Centered (Dissolve or Crossfade)

0.20 Cross [

If you drag the transition so that it is centered on a cut, this will
animate the first clip out and at the same time animate the second
clip in.

000006.mp4

Figure 13-4 Transition - centered on cut

Tips and Tricks: You can even add two transitions to a single cut point (one ending at the cut
and one starting at the cut). This will result in a dip to black.
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Trimming and Setting Durations of Transitions

e To trim a transition, tap once on the transition and then drag the head or tail handle left/right.

Tips and Tricks: For more accuracy when trimming, zoom into the Timeline by pinching open
with two fingers, or triple tap to zoom into the Timeline to frame level. Triple-tap again to zoom
back out.

Setting the Default Transition Duration

¢ In Help and Settings {?} under Preferences, you can set the default duration for new transitions
added to the Timeline. This will not affect existing transitions.

Assuring Media is Available for a Transition

By default, LumaFusion will make sure there is enough media to play through the entire transition by
shortening your Timeline clips when necessary. However, in order to maintain inter-track sync
whenever possible, LumaFusion will only shorten Timeline clips under the following circumstances:

¢ [f the transition is being added between video clips and one or both of them do not have enough
media to play through the transition (Note that photo and title clips always have enough)

¢ If you have Ripple Main Track for transition insert turned ON in the LumaFusion Help and
Settings {i}' under Settings
e If you are in Insert Mode on the Timeline

¢ If Ripple Main Track for transition insert is turned OFF and there is not enough media from
either of the clips, you will see an A and/or B indicator on the transition to indicate that there is
not enough media from the A or B clip, and if you select the transition, a warning will appear
above the transition: “Clip before/after transition needs to be trimmed to play through
entire transition.”

You can either trim the tail of clip A and head of clip B to provide enough media (and you will see a
blue highlight during trimming to help you see how much should be trimmed) or you can ignore this
warning. If you ignore the warning the video from the clip lacking media clip will freeze for part of the
transition.
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14. Timeline Toolbar

The Toolbar at the bottom of the provides the available editing tools. Some tools will be unavailable
if there is nothing selected on the timeline. This chapter outlines where to get more information on
each of these tools.

Figure 14-1 The Timeline Toolbar

Project Manager
This button will be highlighted when the Project Manager is open, and you will see a set of tools
dedicated to managing projects.
£ .
e Tap =!to open the Project Manager.

o Tap the Project Manager button again or double tap a project to close the project manager and
open a project.

For more information, see

Track Header

The track header holds tools that apply certain behaviors to the whole track rather than just a single
clip on a track, or the project as a whole such as Locking, Viewing, Linking and
Muting a track.

.-

e Tap on the Track Header button -:- to show or hide the Track Header.

For more information, see:

Audio Mixer

Adjust the audio levels or mute each track on the Timeline independently or adjust
the master output level for all tracks at the same time. Adjust the overall audio
output level with the Master Level Control on the left side of the Timeline.

Figure 14-2 Track
Header

[
e Tap the Audio Mixer button il to reveal the full track mixer.

For more information, see

Clone Clip

e Tap to make a copy of the selected clip and place it in the Timeline.

For more information, see
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Detach Audio from Clip

Detach is available only when the selected clip has video and audio.

e Tap to detach the audio from a selected video clip, placing the detached audio on an
available audio track.

The audio for the video clip will be muted. This is useful for creating special cuts where audio and
video start or end at different times (L and J cuts). You can also triple tap a video clip to detach the
audio.

For more information, see J-Cut and L-Cut

Link/Unlink

) 0
e Tap " to Link or &~ to Unlink the selected clip from a clip on the Main Track.

When a clip is linked, you'll see a small connection line between it and its master clip on the main
Timeline.

For more information, see: Clip Linking

Edit Clip

e Tap the Edit Clip button :f or double tap on the clip in the Timeline to open one of the five clip
editors.

For more information, see Clip Editor Basics

Presets
Tap the Presets button to open a popup with presets you can apply to the selected clip. The
contents of the popup depend upon the type of clip selected.

For more information, see: Effect Presets

Clipboard

Cut, Copy and Paste one or more clips, with or without their effect attributes, or copy the attributes of
a clip and apply those attributes to another clip or selection of clips using the Clipboard button =],
The copy/paste information is held temporarily. If you want to save attributes to use them again and
again, saving a preset will be more useful.

For more information, see: Clipboard
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Timeline Multiselect

Select multiple clips on the timeline to cut, copy and paste (including paste between projects) move,
delete, unlink, or detach audio for those clips.

For more information, see: Timeline Multiselect

Split Clip(s)

Splitting a clip is a fast way to divide a clip in order to remove, trim or replace a section.

e Tap % to split clips at the current time.

If you have a clip selected, only that clip will be split. If no clip is selected, then all clips that can be
split at the current time will be split. Split will be disabled if you cannot split any clips at the current
time.

For more information, see Split Clip(s)

Add Clip

o Tap the Add Clip button @ to add special clips at the current time.

The available types of clips will depend on whether the Timeline play head is aligned with a cut or
placed anywhere over a clip.

For more information, see Adding Clips

Trash

You can remove a clip from the Timeline and either leave a blank space in its place or close the
gap. The clip will still remain in the Library.

For more information, see Removing Clips

Layouts

gl
e Tap 1 to quickly change the Ul layout.

A popup will appear with different layout options to best fit the way you work and allow you to focus
on specific areas of the user interface for different editing tasks. Choose the one that works best for
you at any given time.

Additional layouts are available if an external monitor is connected to your device.

For more information, see Using an External Monitor

¢é: Lumalouch




Export Project

e Tap @ to export your project.

A popup will appear giving you options for sharing (you can cancel by tapping on the close button or
by tapping outside of the popup). Note: On iPhones with smaller displays such as the iPhone SE, the
Export icon will only be available when editing horizontally or when the Project Manager button is
selected (blue).

For more information, see

Help and Settings

e Tap the Help and Settings button {i}' to access the Current Project Settings, New Project
Defaults or Audio Ducking Settings for the Project. You can set Preferences, Cleanup unused
files, or get more help for LumaFusion.

Add Clip Help and Settings
Headers Detach Audio Clipboard Remove
| = m ) > ~) E=al o N
& [E i = o £ < = 4 @ f

D

Figure 14-3 Press and Hold on the Help and Settings Button for Tooltips

For more information about Help and Settings, see:
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15. Audio Mixer

Adjust the audio levels or mute each track on the Timeline
independently or adjust the master output level for all
tracks at the same time.

o Adjust the overall audio output level with the Master
Level Control on the left side of the Timeline.

1
e Tap the Audio Mixer button il to reveal mixer and

adjust each track independently.

The Audio Mixer button displays yellow on the toolbar if
levels have been muted or adjusted.

Level Meters Figure 15-1 Audio Track Mixer

The Audio Mixer uses a dbFS range. dbFS refers to Decibels relative to Full Scale. The sliders on
the meter and the dB value at the right, refer to the amount of gain or reduction you have applied to
the signal. The colors on the meter refer to the actual dB levels of your audio as shown in the image

below.
The dark green area is The light green The orange area  The very top of the scale
below -20 and is a good area between -20 represents -12to  is 0dB and is the loudest
level for background music and -12db is the -3db and it is signal that can be
and noise. correct level for likely that any represented in digital
the cleanest audio above this  domain without
audio. level will clip. distortion or clipping.

Note: Double tap on a clip to open the Audio Editor and adjust the audio level for that clip.
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16. Voiceover Recording

Record your voice onto an audio track while watching
your Timeline video play.

1.
2.

Tap on the Add Clip button @
Choose Voiceover.

Tap the Options button coo to set the Sample
Rate and Mono/Stereo Channel options for
your recording, or to adjust the microphone
input level using the Audio Input Gain.

X Options

Audio Input Gain

q - @

Sample Rate

Channels Stereo

Figure 16-1 Voice Over Options

Check your record levels and tap the Record button O (or tap to cancel). A three
second countdown will begin and then your recording will start... 3, 2,1

Tap the blue Record button . to stop recording, and then ...

Tap the green Checkmark @ to accept the recording and commit to the Timeline, OR

o Tap Retake D to cancel the recording, and start again

e Tap play D to listen to your recording before deciding whether to keep it.

Figure 16-2 Voice Over — Cancel, Retake, Accept or Listen before accepting

Tip: We recommend connecting an external mic to your device for better audio quality.

iOS sets a default gain level for each input source (internal microphone vs external), but if you
set the gain for input, that gain will be used for all input sources (internal mic or external). To
reset to default iOS values, set the slider to 0 AND restart the LumaFusion App.

Note: All Voiceovers are configured to Master for audio ducking purposes.

For more information on proper recording levels see
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17. Clip Editor Basics

With the Clip Editors you can create custom layered effects, color correction and more. You can add
multiple layers of effects to each clip on the Timeline and create motion on each effect using

keyframe animations.
Each type of media (video, audio, or title) supports multiple types of clip editor to manipulate, adjust
or add effects to your media.

Tilt-Up

Vi N

~ Fit Mode

v~ Cropping

Position X

Position Y

Rotation

Size

Size & Pos (@ ENO)
Size X

Figure 17-1 Frame and Fit Editor
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Opening and Closing the Clip Editors

1. Double tap any clip or tap the Edit button / on the Timeline toolbar with a clip selected.

After the editor opens you will see the available editors across the bottom of the screen for the
media type you are using.

@ ) &
Figure 17-2 Clip Editor toolbar open for a video clip with audio

Select an editor to display the presets, attributes, and controls for that editor.

2. Adjust using the slider controls, or the on-screen display, or add a preset to begin manipulating
an effect.

3. Tap on the Back button < at the top-left corner of the Clip Editor to close the editor and return to
the Timeline. Effects that you created are now applied to your Timeline clip.

Clip Editor Preview

The central area of the Clip Editor is the Preview. Some editors and effects work interactively in the
Preview. For example, in the Fit & Frame editor, you can use your fingers to move, rotate and scale
the image (you can also use the slider controls to do the same thing). When the Preview allows
interactive editing, you'll see interactive controls whenever you stop playing or scrubbing.

Figure 17-3 Frame and Fit preview with interactive controls Figure 17-4 Kaleidoscope effect preview with interactive
controls
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Solo and Hide

T\

o Tap the Solo button ¥V to hear, or @ to show ONLY the current Timeline layer in the
Preview. This is useful if a layer on a Timeline track above the layer you are working on is
obscuring or complicating your view. Tap again to show or hear all Timeline layers again.

e Tap the Mute button ﬁ to mute the layer you are currently working on or the Hide button @
to hide the layer you are currently working on. This is useful if you need a clear impression of
what is below (or behind) the layer you are working on.

Filmstrip / Scrubber

¢ Slide your finger left and right on the Filmstrip to scrub forward and backward through the clip.
e Tap anywhere in the Filmstrip to jump to that time in the clip.

If the clip you are working on has transitions, you'll see the transitions indicated as purple bars at the
start or end of the Filmstrip. Transition animations are not shown in the Preview while in the clip
editor so that you can clearly see the media you are working with.

Timecodes

Above the filmstrip scrubber there are three timecodes. All timecodes are displayed in hours,
minutes, seconds and frames. Timecodes less than a minute will only show seconds and frames
(0.00), and less than an hour will only show minutes, seconds and frames (1:00.00).

e The first timecode on the left is the current position in the context of the project Timeline. So,
this will only show 0:00 if the clip is located at the very start of the Timeline and the scrubber is
located on the first frame.

¢ The timecode in the middle is the current time within the current clip. The location of the Play
head (blue vertical line) determines the current time.

e The timecode on the right is the duration of the clip on the Timeline.

Jump Back / Forward

e Tap the Jump Back button I]<| or Jump Forward |>[| to jump to the previous / next keyframe or
the start / end of the clip.

e Double tap the Jump buttons to jump directly to the start or end of the clip.

Press and hold the Jump button to begin single-frame stepping backward or forward.
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Step Back / Step Forward

e Tap the Frame Step buttons <][| and [“> to quickly move 1 frame at a time backward or forward.

Press and hold the Frame Step button to single-step slowly backward or forward.

Play/Pause/Loop Play

e Tap Play |> to begin playback; tap again to pause playback.

Double Tap the Play button to begin loop-play.
Tap again to stop loop-play.

Press and hold the Play button to open the Incremental Scrubber.

Effect Presets

Quickly set a base color correction or effect and
then, if desired, modify the parameters. The
effects presets are organized into categories:

090
Color

< Tiny Cr‘ysfals - Crystals Big Crystals
Look Up Tables (LUTs) I B
VY T ”ﬁ
Styles & TTﬂﬁr,m 1mﬁ: -’" e
Blurs O Pt SR B 3

et L = g
Ang\es Glass Distort

Distort Effects @
Chroma and Luma-Key Q

and Custom Saved Presets ﬁ

e Tap on a preset within a category to apply it. Figure 17-5 Effect Presets

If the preset includes any effects that aren’t already applied to the clip, the effects will be added.
Otherwise, it will modify the existing effect(s) on the clip.
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Saving and Recalling Presets

1. Tap on the Save Preset button '{J& .

2. Name your preset in the pop-up panel.

3. Tap the Save Preset button ﬁ again.
All effects in the effects stack and their attributes will be saved as your preset. The effects will
remain independent and editable when the Preset is later applied.

At the top of the Presets you'll see several categories. The Saved Presets category ﬁ holds any
custom presets you’ve saved.

1. Tap the Saved Presets button ﬁ in the presets Library.

2. Tap on a preset to apply it.

Sharing, Renaming and Deleting Presets

e Press and hold on a user-saved preset to get a menu of options:
Rename - Tap to display a panel where you can name your preset.

Share - Tap to share the preset. Select one of the standard cloud storage destinations or select
Other App/AirDrop to send the preset to another device with LumaFusion installed or save it on your
Mac. Presets can be imported by using the Import Media option from the LumaFusion main Library,
or by using open-in from another app.

Delete - Tap to delete the selected preset.

Y]
FiLMiC deFlatV2-1
Control Group Stack B—
Layer, reorder, delete and turn the effect’s visibility on or off using
the Control Group Stack. Center 0.00, 0.00
Each effect can be expanded or collapsed by tapping on its _e Amount 57.588

Control Group header.

. . . . . . Kaleidoscope 3
Some Clip Editors like the Frame and Fit editor start-up with some

Control Groups already in the stack, such as Size and Position,
while other Clip Editors, like Color and Effects start with nothing in
the stack until a preset is added.

Figure 17-6 Layered Effects in the Stack
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Creating Keyframe Animations

Smoothly animate the motion, effect properties or color over the length of your clip using keyframing.

~ Fit Mode

~  Cropping

Position X

Position Y

Rotation

39.21
[ oA R AR AR AR R nt:;:«qu(?agg:f N NN N i il il Size

—
== ?)
El C) Size X

Figure 17-7 Creating a keyframe animation

To Add Keyframes
1. Open the Frame and Fit Editor, the Color and Effects Editor, or the Audio Editor.
2. Expand a Control Group or Effect.

3. Tap on the Add Keyframing button ((e
This will turn on Keyframing and will add an initial keyframe at the play head position.

A blue dot will be shown on the Control Group next to the name, and next to the Frame and Fit tab to
indicate animation keyframes have been set.

4. Move the play head to any time within the clip and adjust any attribute to automatically add a

new keyframe or tap the Add Keyframe button e to add a keyframe without changing any
parameters. A smooth motion will play between keyframes.
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To Modify Keyframes

1. Tap on the blue keyframe dot on the Filmstrip to select a keyframe; or use the Jump buttons H<]
and |>|] to jump to the previous or next keyframe to select a different keyframe.

2. Reset the values by double tapping the Preview while the keyframe is selected.

The value of a keyframe will hold until the end of the clip (and backwards to the start of the clip),
unless another keyframe is set. So in order to see animation, you must have at least two
keyframes with different values set for each.

To remove a single keyframe:

1. Select the keyframe - either tap on the keyframe or jump to the keyframe using the Jump buttons

|:|<] and [>ﬂ

2. Tap on the Delete Keyframe button @ Values between keyframes will be recalculated.

To remove ALL keyframes for a Control Group:
1. Open the Control Group for the effect.

2. Tap on the Remove Animation button ((0

Undo/Redo

Undo levels are saved back until the point the project was last opened or the app was last restarted.
e Tap the Undo button G\ to undo your last actions change-by-change.

e Tap the Redo button fj> to redo any changes you have Undone.

Exiting a Clip Editor

o To exit a Clip Editor, tap on the Back button < at the top left of the Preview.
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18. Audio Editor

The Audio Editor works upon a single clip from the Timeline. Here you can adjust the volume,
panning, channel mapping (for stereo audio) and assign a role for audio ducking. When a control
group (such as Volume or Panning) is expanded, keyframing can be turned ON for that group so that
levels and panning can be adjusted over the length of the clip.

For more information, see

~ Configuration

Volume -12.8 dB

: ~ Pan
6.17
Al A T Sl %I )

Volume K a > D D B ®

4/—‘\‘\/_

Figure 18-1 Audio Editor with keyframing

Audio Channel Configuration

Channel configuration or channel mapping allows audio from the left or right channel of a stereo clip
to fill both channels on the Timeline clip. This is useful if you have camera audio on one channel
(often used for background or natural sound) and separate mic audio on the other channel (often
used for voice), or any two independent audio recordings on stereo channels.
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Filling both channels of a clip with one recording source allows you to edit and control the level of
each channel independently.

1. Triple tap on the video/audio clip to separate the audio onto a
new track. Channels Fill From Right

2. Triple tap the video/audio clip again to separate the audio Ducking Master
onto another new track.

~ Volume

3. Double tap each of the audio clips to set the configuration on
one track to Fill from Left and the other to Fill from Right.

v Pan

Figure 18-2 Audio Channel Mapping

Audio Ducking

The Audio Ducking feature is commonly used for automatically lowering the level of music whenever
your interview subject speaks on a different Timeline track.

To set up your clips for ducking:
1. Place your voice clips on one track (it can be a video+audio or audio track).

2. Double tap on the clip to open the Audio Editor, open the Configuration control group. Under
the Ducking setting, assign this voice clip as Master, and then return to the Timeline cut and trim
it as you like.

3. Place your music clip on the audio track below.

4. Double tap on the clip to open the Audio Editor, open the Configuration control group. Under
the Ducking setting, assign this clip as Auto. Auto is the default value, so it is likely already set.

The parameters of audio ducking are located in Help and Settings button é:f? on the Ducking tab:

e The Duck Start Time and Duck End Time control when your music will lower and raise in
relation to the start and end of your master clips on the Timeline.

e Duck Speed is the time it takes to ramp up and down.

Duck Threshold overrides the Duck Start and End Times and starts and ends the ducking
whenever the audio levels on the master clip reach the specified level. Using a threshold of minus
infinity (--=) will switch back to using the Duck Start and End Times in relation to master clips.

Note: All Voiceovers are configured to Master for audio ducking purposes.
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Volume

To adjust the overall clip volume:
1. Tap on the Volume Control Group in the Audio Editor to expand it.

2. Use the Volume slider to increase or decrease the volume.

To vary the volume over the length of your clip:
1. Tap on the Volume Control Group to expand it.
2. Tap on the Turn ON Keyframing button ((0

3. Play the clip and adjust the volume slider as it plays, OR

4. Place the play head at any location and adjust using the volume slider..

Gestures:
Pressing and holding the small arrows to either side of any slider to adjust incrementally.

Pressing and holding the Play button will start Loop Play which can be very useful when
adjusting audio.

Double tapping on eht evolume slider resets it to 0.0dB

Panning

To adjust the overall clip panning:

1. Tap on the Pan Control Group to expand it
2. Use the Pan slider to Pan left or right.

Note: Panning can currently only be used with clips that have stereo audio.

To vary the panning over the length of your clip:
1. Tap on the Pan Control Group to expand it.

2. Tap on the Turn ON the Keyframing button ((0

3. Play the clip and adjust the pan slider as it plays, OR

4. Place the play head at any location and adjust using the pan slider.
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Audio Filters

A number of Apple approved Audio Unit (AU) filter plugins are available for processing your audio.
Audio Units (AU) are a system-level plug-in architecture provided by Core Audio in Apple's iOS
operating system.

To add a filter:
1. Tap on the filter in the Audio Editor’s Library Presets.

2. Adjust the controls available for the filter. Keyframing can be turned on for filters.

For more information, see Creating Keyframe Animations

To remove a filter:
1. Open the Control Group for the Filter.

2. Tap the Trashcan button @ in the Control Group header.

Monitoring Controls

Solo

T\
o Tap the Solo button UL temporarily mute the playback of other tracks on your Timeline.

Mute

o Tap the Mute button M to temporarily mute the playback of the current track on your Timeline.
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19. Frame and Fit Editor

Create picture-in-picture, crop, resize, position, rotate or flip, or use keyframing to create Ken Burns
effects on photos, videos or even titles using the Frame and Fit Editor.

While the Frame and Fit Editor works upon a single clip from the Timeline, resizing or cropping the
clip will show through to the clip positioned on a track below on the Timeline, making it a powerful
multi-layer effects editor.

Effects created using Frame and Fit can also be combined with the effects from the Color and
Effects Editor as well as Speed Effects.

For more information, see

Top
Right

Bottom

| Edge Softness

e

=] @) Corner Radius

<+ Qizn and Dacitinn

Figure 19-1Frame and Fit Editor - Soft Crop
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Opening the Frame and Fit Editor

e Double tap a video or photo on the Timeline, or if you are working with a title, double tap the title
[N
to open the Title Editor and then tap on the Frame and Fit tab Lﬁ , OR.

e Tap on a preset in the Preset Library to apply it to the clip, OR

e Tapon aclip in the Timeline and then tap on the Edit button fon the Timeline Toolbar.

Frame and Fit Tools

Flip

o Tap on the Flip button A to flip the image horizontally so that the left is on the right and the
right is on the left. Text will be shown backwards when flipped.

Rotate

!
e Tap on the Rotate button [ to rotate the image 90° counterclockwise for every tap.

Reset

e Tap the Reset button to reset the values for the open Control Group.

Tips and Tricks: If keyframing is turned on when you tap reset, only the current frame will be
reset in that Control Group and a keyframe will be created if there is not one at that frame
already.

Fit Mode

When the aspect ratio of your project is different than the aspect ratio of your source media, the Fit
Mode determines how the media is displayed.

o Tap one of four Fit Mode buttons to change how your media fills the frame.

The Fit button assures that all edges of the media fit within the current aspect ratio of your
project.

The Fill button assures the frame is filled, leaving no black edges. In most cases this means
zooming into the media to fit the smallest aspect of the media to the largest aspect of the project
frame.
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The Focus button gl is a special mode that is convenient for video shot in portrait mode that is
being edited into a project in landscape aspect ratio. It works like Fill mode but focuses the view
closer to the top of the frame where faces are usually located.

The Stretch button Stretches the edges of the clip to meet the edges of the frame with no
regard for keeping the original shape of the video. Images will appear stretched in one way or the
other depending on how the aspect ratio of the image differs from the project aspect ratio.

Stretch is useful for ‘squeezed’ media from anamorphic lenses like the Moondog Labs lenses. You
can create a widescreen project and then stretch the 16:9 media to ‘unsqueeze’ it to the widescreen
frame.

Crop, Corner Radius, Soft Edge and Invert

Open the Cropping Control Group to crop away the left, top, right or bottom edge of the image, or
invert a crop to frame an opening.

e Use the sliders to adjust each edge or tap on the left and right arrows at the end of each slider to
adjust incrementally, OR

e Drag the blue boxes on the edge of the yellow frame in the Preview to crop.
e Drag in the center to move the cropping box around the frame.

e Drag the Edge Softness slider and Corner Radius slider to soften the edges and change the
shape.

e Tap Invert to show what is outside the defined crop area, leaving a blank space inside.

Size and Position

Open the Size and Position Control Group to adjust the size, shape, rotation and position of your
image in the frame.

e Use the sliders to adjust the Position X (left/right) and Position Y(up/down), Rotation, Size, Size
X and Size Y, or tap on the left and right arrows at the ends of slider to incrementally adjust the
sliders, OR

e Drag the blue dots on the edge of the blue frame in the Preview to adjust the Size X and Y.
e Drag the corner dots to preserve the aspect ratio
e Drag in the center to adjust the Position X and Position Y.

¢ Rotate with two fingers to adjust the Rotation.

Blending

Open the Blending Control Group to set the overall Opacity and Blend Mode for the image.
Use the slider to adjust the Opacity of the selected clip.
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Use the Blend Mode picker to select different modes for blending the selected clip with any imagery
below it. Blend Modes will normally have very little effect if they are used on the Main Track. Use
blend modes to create interesting compositing effects between video clips, titles, and images.

o Normal Paints the select image over the background, using the opacity of the image (and the
opacity slider) to determine how each pixel is blended with the background.

o Darken Returns the darker of each pixel of either the selected image or background image.

e Multiply Multiplies each color channel of the selected image with the background, producing a
darker color. Any color blended with white is maintained, and any color blended with black turns
black.

e Color Burn Darkens the background image by increasing its contrast with the selected image.

e Linear Burn Darkens the background image based on the brightness of each color channel of
the selected image.

o Darker Color Returns the darker of each color channel from either the selected image or
background image.

o Lighten Returns the lighter of each pixel of either the selected image or background image.

e Screen Multiplies the inverse of the selected image and background colors, producing a lighter
color; It can look like projecting multiple slides on top of each other.

e Color Dodge Decreases the contrast between the selected image color and background color,
producing a lighter color (except when blending with black).

e Linear Dodge Brightens the background image based on the brightness of each channel of the
selected image.

o Lighter Color Returns the lighter color for each color channel of the selected and background
image.

e Overlay Multiplies the colors, preserving the highlights and shadows for the background image.

o Soft Light Darkens or lightens the colors of the background image, based on the selected
image’s colors. Lighter colors in the selected image will brighten the background, and darker
colors will darken the background. Use this with white shapes to create a soft light effect.

o Hard Light Darkens or lightens the colors of the background image sharply based on the
selected image’s colors; use this with white shapes on a gray background to produce a hard
spotlight effect.

e Pin Light Replaces the colors of the background image. If the selected image color is brighter
than 50% gray, then only pixels darker than the selected image color are replaced. If the
selected image color is darker than 50% gray, then pixels darker than the selected image are
replaced, but lighter are not.

e Hard Mix Adds the color channels of the selected image to the color channels of the
background, clamping the colors between black and white.
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¢ Difference Subtracts the selected image color from the background image (or vice-versa
depending on which color is brighter), producing darker colors where the colors are similar and
brighter where they are different.

e Exclusion Subtracts similar to ‘Difference’, but with a lower contrast image as a result.

e Subtract Subtracts the selected image color from the background image color, and clamps to
black (zero).

¢ Divide Divides the selected image color from the base color, creating a bright, almost x-ray
effect.

¢ Hue Uses the luminance and saturation of the background image, and the hue of the selected
image.

e Saturation Uses the luminance and hue of the background image, and the saturation of the
selected image.

e Color Uses the luminance of the background image, and the hue and saturation of the selected
image. This preserves the gray levels of the background image and can be useful for tinting the
background with colors from the selected image.

¢ Luminosity Uses the hue and saturation of the background image, and the luminance of the
selected image. This effectively tints the selected image based on the background (the inverse
of the Color blend mode).

¢ Stencil Alpha Inverts the alpha (transparency) of the selected image and replaces transparent
pixels with black. This is useful with titles to create a stencil through to the video below the title.

e Stencil Luma Colors all pixels in the selected image either black, or transparent based on their
luminance (lighter pixels become more transparent). This is useful for stenciling a grayscale
image or title through to a background video when the image doesn’t have an alpha channel.

¢ Silhouette Alpha Replaces opaque pixels with black to create a silhouette of the selected image

¢ Silhouette Luma Colors all pixels in the selected image either black, or transparent based on
their luminance (darker pixels become more transparent).

For information on saving, applying or deleting a preset see

Saving and Recalling Presets
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Gestures:

With the Size and Position control group open:

Twist the frame using two fingers.

Move the frame using one finger.

Resize the frame by dragging the blue handles on the edges of the blue frame.
With the Cropping control group open:

Crop the frame by dragging the blue handles on the edges of the yellow frame.

Move the cropped area using one finger.




20. Speed Editor

Adjust the speed of a video clip, so it plays either faster or slower, in forward or reverse.

= @

Maintain @
Audio Pitch e

Reverse

Figure 20-1 Speed Editor

Fast and Slow Motion

1. To open, double tap a video on the Timeline and then tap on the Speed tab @.
2. Adjust the speed using the slider.
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Reverse

e Tap the Reverse switch to reverse the video.

The video frames will first be processed in a backwards order. This will take some time depending
on the length and compression of your original video clip. Once done, you can trim the clip or switch
between forward and reverse instantly without further processing.

Maintain Audio Pitch

Toggle on Maintain Audio Pitch to keep the pitch on speeds up to two times normal speed.

Important Tip! This setting applies to all speed effect clips on the same track of the Timeline.

Using High Frame Rate Clips for Smooth Slow Motion

If you have a clip that was shot at a higher frame rate than the current frame rate of your Project,
then you will see a small white vertical line on the speed control slider. This tick mark represents
the slowest speed you can go without duplicating any frames to create the slow motion effect.

Here are some examples:

e Let's say you shot a 240fps (frames per second) clip and added it to a LumaFusion Timeline with
the project set to 30fps. Without a speed effect applied, LumaFusion will use every 8" frame to
smoothly play at 30fps, because that is all the frames needed to play at normal speed (because
240 divided by 30 is 8).

¢ In the example above, if you slow the speed of the 240fps clip to 1/8 then every frame of the 240
frames will be played on the Timeline at 30 of the frames every second, and the slow motion will
still look nice and smooth.

e If your project is set to 60fps rather than 30fps, and your clip is 240fps then you can only slow to
1/4 speed without duplicating frames for the sake of the slow motion. Keep in mind that changing
the frame rate of your final export is the same as changing the frame rate of your project.

¢ [f you slow your media down to a slower speed than your source clip allows mathematically, you
will duplicate frames. Here’'s an example: Let’s say your source was shot at 120fps, your project
is 60fps and you slow to 1/4. Then every frame will be duplicated once to achieve the speed
requested, since there are only half the number of frames as needed for the effect.

With this in mind, you can see that planning your shooting frame rate and your final export frame
rate are both important in order to achieve the smoothest slow-motion effects.
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21. Color and Effects Editor

Color correct and add blurs, distortions, chroma and luma key (including green screen) and a wide
variety of customizable styled effects. These effects can be combined with one another, layered,
reordered and keyframed to create an infinite variety of effects.

While these effects work upon a single clip from the Timeline, any area of the frame that becomes
transparent due to keying or other effects will show through to the clip located on the Timeline track
below, making a powerful multi-layer effects editor. These effects can also be combined with Frame
and Fit Effects and Speed Effects, and can be applied to video, photo and even titles.

For more information, see

~ Vignette 3

~ Vibrance %

Count

@ Center 0.00, 0.00

2 Angle Q 90.0°

P Blend

1:38.00

Figure 21-1 Color and Effects Editor
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Applying Color and Effects

1. Double tap on a video, photo, or title on the Timeline, or tap the Edit button /

2. Tap on the Color and Effects tab @ at the bottom of the screen.

290 <> BEO
3. Tap on the Color , LUTs Qﬂ Styles [ , Blurs @ Distort effects @ or Keys Q button.
4. Choose a preset. A checkmark will be shown on the applied presets.

5. Adjust the settings using the sliders or the Preview overlay controls when present (drag the blue
dot to position the effect, and the green dot to adjust the radius and angle).

6. If a preset has been adjusted from the base settings, an asterisk () will be shown after the
name in the Control Group Stack.

Color

If you want a quick fix, or a bit of inspiration, we’ve created a
collection of fun color presets. For instance, choose “Office” to
counteract green fluorescent lighting you might find in an office
setting. Or choose “MiniMart” if you want to create fluorescent
green light! To make your daytime video look like it was shot at
night, choose one of the nighttime presets; Dusk, Moonlight, or
Midnight.

If you want to start adjusting without adding a preset, tap the
Original preset and make changes from there. No matter what
preset you pick, you can continue to make your own adjustments.

1. Double tap on a video, photo, or title on the Timeline, or tap

the Edit button £ . Brightness
2. Tap on the Color and Effects tab @ at the bottom of the e

screen.

Saturation
3. Above the presets you will see multiple effects categories, the ®
300 Vibrance

first of which is Color ~2J . 0=
4. Tap on any of the presets to get started, or tap on the first Highlig.ht/Shadow Radius

preset, Original. Tapping a preset will apply the preset

(overwriting any existing color correction) and display the Highlight Amount

settings that make up that preset. Figure 21-2 Color Correction
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Levels

Five points on the Levels sliders allow you to set the brightness for each range and the contrast
between them.

Brightness

Brightness lightens or darkens evenly across all colors of your image.

Contrast

Contrast adjusts the luminance difference between the dark and light areas. This setting is useful
when working with videos and photos that have an overall muddy impression.

Saturation

Saturation increases or decreases how much color is in your image.

Vibrance

Raises and lowers the saturation values of cool colors such as blue and green and has less effect on
warm colors. This is useful for leaving skin tones intact while increasing the saturation of other
colors.

Highlight/Shadow Radius

Adjusts the number of pixels used to transition from shadow areas to highlight areas. You may not
see much effect on a normal image.

Tips and Tricks: To better understand the highlight/shadow radius setting, set your Highlight
Amount to 0 and your Shadow Amount to 1.0 and then make adjustments to the
Highlight/Shadow Radius.

Highlight Amount

Allows you to adjust the highlight levels without affecting the shadows.

Shadow Amount

Allows you to adjust the shadow levels without affecting the highlights.

Color Temperature - Red / Green / Blue

There are three controls for the color temperature. Each slider adjusts the temperature between a
primary color (Red, Green, Blue) and their secondary counterparts, (Cyan, Magenta, Yellow).
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The colors in your video clip are a balance of all of these colors. Sometimes the color may seem “out
of balance”. For example, perhaps your clip was shot on a cloudy day and it looks too Blue or “Cold.”
If you want to add warmth, you can either move the blue slider towards the yellow, or you could add
red, and magenta from the green slider. Either way, you are shifting the balance between the 3
primary colors. Most of the time, you will be making subtle adjustments to each of these colors.
Experiment with the colors. Push it all the way so you get a feel for how color balance works.

Gamma

Since cameras record a larger range of brightness than a typical screen can reproduce, there are
often details in your image that are hidden when viewing on a screen. Imagine you have a range of
luminance and color from very dark to very bright. Now imagine you can only display a limited
amount of that range, so you have to adjust the range to decide whether you want to see more detail
in the shadows or alternatively, more detail in the highlights. The Gamma correction lets you decide
how to reproduce the color luminance in your images. It is very often used to deepen the dark areas
without losing bright areas.

Hue

Unlike the Temperature control sliders, the Hue rotates the phase of all colors equally. Normally you
won’t need to adjust the Hue, but it can be used to create an inverse Color effect.

Tint

Last is the Tint. It adjusts the color of white. And when you’re talking about light, all colors contribute
to white, so you will see an overall cast when you adjust this setting, but you will see more effect in
the pure white areas.
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Using the Color Picker

Tap the color dot or eyedropper to display the color panel:

e Choose a color from the grid, OR

e Drag your finger around the spectrum, OR

e Adjust the RGB sliders, or type in RGB numbers, OR

o Tap the Hex Color to add a color number (choose SRGB or Display P3 Color Space)

e Tap on the plus button to store a color sample.

e Tap on the color picker at the top of the panel to display the color reticle to select a color from
the image

Figure 21-3 Grid Color Picker, Spectrum Color Picker and RGB Sliders with Hexadecimal Input
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Color LUTS (Look Up Tables)

<>
Look Up Tables (LUTSs) N are a set of numbers that make up the
difference between your source footage and a desired “look.”

Camera manufacturers provide certain log profiles that control the
variables of your image, so that you can apply the corresponding
LUT in post-production. Often these log profiles create images
that appear flat or low contrast, since highlight, shadow and tonal
detail are prioritized over contrast and saturation. This provides
the opportunity to bring out the dynamic range and still keep
detail, by using a LUT specifically designed for that log profile.

FILMiC deLogV2 " FILMIiC deFlatv2

Keep in mind that a LUT only achieves a specified look if your
original source was shot with a profile intended for use with that
LUT.

. L " . LUT FiLMiC deLogV2.CUBE (64 points)
You can potentially get close to a certain “look” using a LUT that

was designed for use with neutral images, but in most cases, this Courtesy of FILMIC Pro. Tap to learn more.
will only get you in the general direction of the look since your Blend 0,00
source image will not perfectly match the LUT designer’s source
image.

Figure 21-4 Color LUTS (Look Up Tables)
Applying a LUT

LumaFusion provides a variety of Look Up Table presets or LUTs, including FiLMiC deLog and
FiLMiC DeFlat, and several stylized LUTs intended for use with neutral footage. You can also import

your own LUTs by tapping the Import button m
1. Double tap on a video, photo or title on the Timeline, or tap the Edit button /
2. Tap on the Color and Effects tab @ at the bottom of the screen.

<>
3. Taponthe LUT N g category at the top of the presets.
4. Tapona LUT preset.
5. Move the Blend slider to adjust the intensity of the LUT’s effect.
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Importing a LUT
LumaFusion imports .cube or .3dl Look Up Table (LUT) files.
To import a LUT:

1. Tap the Import LUT button m located above the LUT control header.

2. Tap on the storage location where your LUT is stored. You may have to log into the location if
you haven’t done so before.

3. Tap on the LUT, and then tap on Import M

Deleting a LUT

To delete a previously imported LUT:
1. Press and hold on the LUT preset in the presets Library.

2. Choose Delete from the menu.

Tips and Tricks: You can apply a LUT preset in addition to a LumafFusion color effect from the
Color category and once applied you will see them both in the effects stack.
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Styles, Blurs, and Distort Effects

Styles

Styles create effects ranging from vignettes and duo-tone
washes, to edge effects and comic effects. Style effects act upon
the pixels of your image without moving the base image pixels
vertically or horizontally. Your Style effects can be applied before or
after other color effects, and multiple Style effects can be applied to
photos, videos, and titles. Style effects can be keyframed to modify
the look over time.

Blurs and Sharpens

Blurs @ create various blurs, sharpens, and swishes. Blur and
Sharpen effects change how neighboring pixels blend with each
other. Blur and Sharpen effects can be applied before or after other
color and effects, and multiple blur or sharpen effects can be ~ Kaleidoscope 4 3
applied to photos, videos and titles. Blur and Sharpen effects can be
keyframed to modify the look over time.

< Vignette 3

- Vibrance %

® Radius

Distort Effects ® Angle

Distorts @ create effects such as kaleidoscopes, pointillize, mirror,
and twist. Distort effects distort the size, position and shape of pixels
in your image. Distort effects can be applied before or after other
color and effects, and multiple distort effects can be applied. Distort
effects can be keyframed to modify the look over time.

Figure 21-5 Blur Effects
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Chroma Key and Luma Key

Chroma Key g allows a color such as a green screen to be replaced with the media on the layer(s)
below on the timeline. Respectively Luma Key allows replacement of a luminance value such as

black or white.

Keying can be used to composite two images such as placing a man over an office background like
the image below, or keying can be used to mask an area of the video for isolating effects or color
correction by layering identical clips over one another on the timeline, adding the key to the top

layer.

6:29 AM Sun Nov 15

b
Al

Dark Contrast

»
‘ Key Color
Hue Range
Saturation Range
_ Brightness Range
| O
Erosion Distance
___ Edge Blur Radius
ENO; :

Spill Suppression

Figure 21-6 Completed chroma key

Lumalouch

&b
Contrast

gl

ShadowUp

ik
ol

High Contrast

4
attl

Vibrance




Ap
1.
2.

8. To reset the key to the automatic value tap on the Magic

[ 33
[ L 1N
00e

plying Chroma Key Effects

Place your background clip on the Main Track.

Place your foreground clip (with the color or
luminance you are keying out) on the track
above. This can be a photo, video, or title.

Double tap on the top clip to open the Clip
Effects

Tap on the Color and Effects tab @ at the
bottom of the screen.

Tap on the Key category 8

Tap on the Chroma Key preset if you want to key out a color,
or the Luma Key Preset if you want to key out a light or dark

area.

The Chroma Keyer will attempt to calculate the key color by
analyzing the current frame in the Preview when the effect is
added. This may be perfect on some images, but less
accurate on others depending on the content of the frame.

Modify the resulting key by one or more of the following

methods:

a. Use the slider controls.

b. Choose a different color using the eye dropper f

5.25 Man appearing sharing secret and disappearing over {

8

m 5.25 Business people working in office, de-focused
» »

)

Figure 21-7 Green screen clip above a background clip on
the Timeline

Y

Key Color

Hue Range

(drag it to the screen). @
c. Tap on the circle to open the color picker to manually S e
input a color.

For more information, see

Wand button%. This will recalculate the key color by

analyzing the current frame in the preview.

Lumalouch

Brightness Range
Erosion Distance
Edge Blur Radius

Spill Suppression

Figure 21-8 Chroma Key Settings



Applying Luma Key Effects

1. Place your background clip on the Main Track.

2. Place your foreground clip (with the luminance
you are keying out) on the track above. This
can be a photo, video, or title.

3. Double tap on the top clip to open the Clip
Effects

4. Tap on the Color and Effects tab @ at the
bottom of the screen.

5. Tap on the Key category 8
6. Tap on the Luma Key preset.

7. The Luma Keyer will attempt to calculate the
key value by analyzing the current frame in
the Preview when the effect is added. This
may be perfect on some images, but less
accurate on others depending on the content Figure 21-9 Foreground and background clips on the
of the frame. Timeline

pa a l) 8.01 Jumbo Jet F\in Overhead

g s¢
offi 8107 The man stand on|a background of a milky way with

8. You may have to use Reverse Key in the settings of the

effect.
Luma Range
9. Modify the resulting key by adjusting the Luma Range, Rolloff, C o
Erosion Distance and Edge Blur Radius. _
B, 4
Rolloffl 59
Applying Color with Keys ®
Erosion Distance
Note that you may apply other effects either before or after the @
key including Frame and Fit, Cropping or Color. Edge Blur Radius
@ :

Applying a color effect before a key will have a different effect
than applying it after the key. Most importantly, if color is applied
before the key (placed higher on the effect stack), adjusting the
color will also adjust the key response. Figure 21-10 Luma Key Settings

Reverse Key

You can re-order the effects by dragging the effect lower or higher in the stack.

For more information, see:
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9:41 AM Tue Jan 9

@ &

Figure 21-11 Finished Luma Key with color effect applied after

Show Mask

Tap the Show Mask button '® |ocated at the top
of the FX preview to show the foreground image
as white only, allowing more precise adjustments.
The mask will not be visible if you open any of the
other effect editor tabs, turn off the key effect or
leave the editor.

+ Lumalouch

all T ¢ 68% @)

Chroma Key Luma Key

Luma Range

* Rolloff

Erosion Distance

Edge Blur Radius

Reverse Key

~ Dark Contrast

Figure 21-12 Showing a key mask




Filling Text with Video Using
Chroma Key

To fill text with video AND have video in the
background you will need to do an intermediate
mixdown step to flatten the text or matte with the
background.

Steps for Filling Text or Graphic

1. Create a title with a bright and saturated color fill
that does not match colors in your background
clip, and if desired add a border and shadow.

2. Place the title on a new Timeline above your
desired background clip.

3. Add motion to the title if desired, using the Frame
and Fit editor.

4,00 Plain-White
TRAVEL
I

4. Tap on Export > Movie and choose the e
Rendered Movies Folder as the destination. This -
will create a file and place it in the Library under
Imported > Rendered Movies.

Figure 21-14 Brightly colored title over background clip

5. In the project where you want the final, video-
filled text, place the clip that you want to fill the VA
text onto a track on the Timeline, then place the e
rendered movie on the track above it. 417 Bvening over the Fields and Hi g

6. Double tap on the rendered movie and key out the

fill color from the text to reveal the video below.
Figure 21-16 Rendered Composite over the "fill" clip

For more information about adding a Key effect, see

Note: If you want to quickly fill a title with video and display it over a black background you can use
the Blend Mode “Stencil Alpha” in the Frame and Fit Editor.

For more information about adding Blending, see
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Layer Controls

Reordering Color, Effects and Keys

Achieve new looks by switching the order in which effects are
applied to your clip.

In the Color and Effects Editor @ each preset added to the
Control Group Stack contains the controls for a separate effect
that has been applied to your clip. You can add multiple effects to
a clip, thus building a “Stack” of effects.

To change the order:

e Collapse all layers by tapping on the blue text for the open

Iayer ~ Vignette 3

~ Vibrance %

e Press, hold, and drag the handle  to move the effect layer

up and down the Stack.

Effects at the bottom of the Stack are applied last, so moving an ¥ Motion 40

effect higher in the Stack applies that effect before other effects in
the Stack, providing endless possibilities for customizing how your

effects look. Figure 21-17 Reordering an Effect in
the Effect Stack

~ Vignette 3

Turning Effect Visibility ON/OFF

Compare what your clip will look like with vs. without a certain
effect (without deleting the effect).

~ Vibrance %

@
e Tap the Visibility button <SP in an effect’s header to turn OFF

or ON viewing of that effect. © Center 0.00,0.00

2@ Angle Q : 166.4°

Blend 0.00

Deleting an Effect

e Expand the Control Group for the effect you want to delete. Figure 21-18 Kaleidoscope visibility
turned OFF

e Tap the Trashcan button @ .
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22. Title Editor

Create custom multilayer titles. Choose your own font, colors, borders, and shadows as well as
import graphics, shapes and additional text layers. Or start with one of our many presets and modify

as you like.

YOURYOURYOUR
PR O

K
~ Shape

~ YOUR TEXT HERE

Opacity

AvenirNextCondensed-Regular

Size

Line Spacing

Figure 22-1 Title Editor
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Adding a Title to the Timeline

To add a title to the Timeline:

[ 33
o0L
00e

Shades-Right Shapes-Lower

Touch, hold and drag a title preset from the

Titles T section of the Library to the
Timeline.

3840x2160 16:9

If you drag the title to a position on the
Timeline where no media is on a track below,
then the Title will display over black. If you add
a title and there is video or photo media on a
track below, then the title will display over that
media, OR

Figure 22-2 Dragging a title from the Library

Tap the Add Clip button @ on the Timeline and choose b Add Clip
Overlay Title or Main Title.
Overlay Title will add the title to a track above the Main Track & Voiceover

on the Timeline and the title will display over the Main Track

media. 7] Transition

You must be positioned at a cut point on the Main Track to
see the Main Title option. 1 Blank Clip

T Main Title

[T} Overlay Title

Figure 22-3 Add Clip menu
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Opening the Title Editor

Open the Title Editor for full customization of your title.

Once the title is on the Timeline:

¢ Double tap the title clip to open the full Title Editor or select the title on the Timeline and tap the
Edit button / . Text, Shape and Image Layers

Selecting a Title Layer in the Titler
Selecting a title layer opens the Control Group where settings can be adjusted. To select a title layer:
e Taponitinthe Preview, OR

e Tap on the Control Group for that layer.

Add a Text, Shape, or Image Layer

Create richly layered titles by adding text, shapes, and images. Unlimited layers can be added to a
title. To add a layer:

1. Tap the Add Layer button .
2. Choose the layer type.

Text Layer T® Adds a default text layer.

©

e Modify using the settings or by selecting one of the Styles == from the presets Library.
Oo®
Shape Layer C+r Adds a default rectangle shape layer.

ao
e Select the desired shape from the Shapes Osx Library.
o Adjust the color, border and other parameters in the settings, or by selecting one of the Styles

O

== from the presets Library.

Image Layer @ Adds a default “Select Image” layer.
e Select the desired image from the Images Library, OR

e Tap Import Image located in the settings for that layer.
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Editing Text
To change the text of a text layer:

e Double tap the layer in the Preview, OR
8
Select the layer and then tap the Edit button ],

e Font, size, and color can be adjusted while the keyboard is open using the font buttons

T A A

z;’; &our Text Heri

delete

caps lock return

Figure 22-4 Changing the text in a title
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Quick Editing Text in the Preview ——

™ Your Text Here

e Select the title on the Timeline, and then tap

I Your Text Here

the Info button @ and expand the panel with ) Add Notes
the More button coc. On the expanded Info ® coores @
panel, you can quickly edit the available lines " ;
of text in a text editor window.

File 06-

Figure 22-5 Quick editing text in the Info Panel

Pasting Text from a Nearby Mac Desktop

Copy text using the normal keyboard shortcut on your Mac (Cmd-C) and then paste it to a text layer
in the LumaFusion Titler. Here’s how:

1. Your Mac and your iOS device must both be connected to the same Wi-Fi and be logged into the
same Apple ID.

2. On your Mac, select your text and press Cmd-C to copy the text to the clipboard.

3. In LumaFusion, with a text layer selected in the Titler, open the keyboard by double tapping on

4
the layer in the Preview or by tapping the Edit button )

4. Tap the Paste button at the top of your onscreen keyboard, or press Cmd-V if you have a
hardware keyboard connected to your iOS device.

Duplicate Layer
Make an identical layer on top of the existing layer.
e Select the layer and then tap the duplicate button .

Turn Layer Visibility ON/OFF

Compare what your clip will look like without a layer or temporarily turn off a layer obscuring your
view (without deleting the layer).

e Tap the Visibility button <P to turn OFF or ON viewing of each layer.
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Changing Layer Order

Titles at the top of the stack are added first and other layers are added on top. Moving a title layer
higher in the stack will place it behind layers located lower in the stack.

e Collapse the current layer by tapping on the blue Control Group Header. Press and hold the
Reorder Handle  and then drag to move the title layer up and down the stack, OR

o Tap the Layer Order button @ to move a layer forward or backward.

Deleting a Layer

1. Expand the control group for the title layer you want to delete.

2. Tap the Trashcan button @

Text Layer Settings

The Control Group holds a variety of settings that determine what the layer looks like, such as color,
font, size, justification, and shadow.

Overall Layer Opacity

e Adjust the slider from 0 (transparent) to 100 (opaque).

Font

e Tap on Font to select from already installed fonts on your device.

For information about installing fonts, see Importing/Loading Fonts

Font Size

e Adjust the slider from 16 points to 400 points.

Layer Justification

oo
o To quickly position the layer and set the justification, tap the Align button Boa .

e Choose Centered, Left, or Right Justified and Top, Middle, or Bottom.

Line Spacing

In layers with more than one line of text, adjust the space between layers from 10% of the text
height, to 300% of the text height.
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Face, Edge, and Shadow Color

Tap the color box to display the color panel:

e Drag your finger around the wheel to select a tint color.

e User the Saturation and Brightness sliders to fine-tune the color.

e Tap the hex number to type a hexadecimal color into the field. Closing the keyboard or pressing
Enter will accept the color.

o Tap one of the color preset boxes to select that color or touch and hold one of the color boxes to
set a preset for the current color.

Face, Edge, and Shadow Opacity

e For each section, adjust the opacity of the color from 0 (transparent) to 100 (opaque).

Edge Width
e Adjust the edge width from 0 (no edge) to 100 (largest edge).

Shadow Angle

e Slide your finger left and right across the Shadow Angle dial to adjust the direction of the
shadow.

Shadow Distance

e Adjust the shadow distance from the text, shape or image, from 0 (no shadow) to 100 (largest
edge).

Shadow Blur

e Adjust the softness of the shadow from 0 (hardest shadow) to 100 (softest shadow).
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Saving and Recalling Presets

Style Presets

A “Style” preset is the collection of settings that make a layer look the way it does. Style presets can
be applied to text or shape layers.

To save a Style Preset:

1. Select a text or shape layer that has the look you want to save.

)

2. Tap on the Save Style button =.

)

3. Name the Style preset and tap on the Save Style button = again.

To recall a Style Preset:

1. Inside the Title Editor, select a text layer or a shape layer.

O

2. Atthe top of the Presets Library, tap on the Styles button ==.

3. If you have saved any custom presets, they will appear under User Styles ﬁ

4. Tap on the Style Preset to apply it to the current layer.

Title Presets

A Title Preset is the collection of layers (including their styles) that make up a whole title.

To save a Title Preset:
1. Tap on the Save Preset buttonﬁ.

2. Name the Title preset and tap on the Save Preset button ﬁ again.

To recall a Title Preset:

1. Inside the Title Editor, collapse any existing layers.

2. Tap on Title Preset to replace the current Title layers with the new layers, OR

1. On the Timeline, select a title.

2. Tap on the Presets button .
3. Choose the Title category T and tap on a preset to apply.

Saved Title Presets can also be found in the main media Library under the Titles T category.
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Importing/Loading Fonts

Import custom True Type Font (.ttf) and Open Type Font (.otf) and font packages into the
LumaFusion Titler. There are three methods:

Font Share to

If you have an app such as Fontasy you can browse thousands of m Anoreuer
ont -
fonts, select one and share it to LumaFusion. You can also email

a font to yourself to import into LumaFusion. o . 7 -
W@
¢ In the font app, choose a font and tap the Share button, OR

AirDrop Slack Notability Notes iXpé

e Open an email with a font file attached. Tap once on the
attachment to download, then press and hold on the
attachment until the share sheet appears.

Save to Dropbox 33

Figure 22-6 Share to LumaFusion share
sheet from Fontasy
Choose LumaFusion from the share sheet. Then the font will be .

available in the LumaFusion Titler. @

Save to Pinterest

Import Fonts from Cloud Storage
If you have a True Type Font (.ttf) or Open Type Font (.off) in cloud storage like Dropbox, you can

use the media import function to import the font into LumaFusion.
onli &
1. Inthe LumaFusion Library, tap on the Import button .

2. Navigate to the location of your font file (select the .ttf file or .oftf file, not the zip file).

3. Tap the Import button m and then the font will be available in the LumaFusion Titler.

Import Font Packages Using the Files App

You can download font packages from websites such as dafont.com.

1. Using Safari on your iOS device, download a font package.

2. Open the Files app.

3. Under Downloads double tap on the zip archive for the font package to unpack the file.
4

Touch and hold the resulting font file and choose the Share option from the list. This will open
the share sheet. If you don’t see LumaFusion on the list, scroll to the right and tap the More
button. From this list tap ‘Open in LumaFusion.”

5. The font will be added to the LumaFusion Titler.

¢é: Lumalouch




23. Export and Sharing

Your project can be exported as a finished movie, an audio-only file, a single frame from your
Timeline (called a Snapshot) or a Project Package (containing your project and media that can be
restored later.

Exporting a Finished Movie

1. Tap on the Export button @ If the Export button is not visible tap once on the Timeline, and
then once on the Preview window to display the toolbar. (On iPhone SE, turn the phone
horizontal to show Export button.)

2. Tap Movie .

3. Select a destination, and log into the destination if necessary. This will only be required the first
time you export to cloud storage or a social network. See details about each of the destinations
below.

Note: If you don’t see your desired destination, tap the Add/Edit Destinations button @

For more information, see Add/Edit Export Destinations

4. Choose the settings for your export. The recommended settings based on your media and the
chosen destination are highlighted with a star (%), but each setting can be adjusted as desired.

If you've exported to the selected destination previously, an option is provided to Change to the
last export settings or Change to the recommended settings for that destination.

5. Navigate to the directory you want to export to (if necessary).

6. Tap the Share button m

Note: The settings panel will show warnings if any of the tracks in your project are muted or
hidden. An estimate of the storage space needed to export the movie is also shown, and a
warning will be shown if there is not enough available storage space to export the movie. If
there is not enough space, and you can’t free up space, try changing to a lower quality or
resolution setting to reduce the export space requirements.
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Export Destinations

Edit Destinations

. . . Available In-Use
Add/Edit Export Destinations 9 Vimeo @ Photos
You can add, remove and organize your export @ Weibo &) Vemse
destinations. Limiting the destination list to the Box Y) Google Drive
items you use will help you stay focused and work & OneDrive €S Dropbox
faster. () GNARBOX - Frame.io
To add, remove or reorder a destination: 2 EERIE R (& Files

@ WD Rendered Movies Fold...

1. Tap on the Add/Edit Destinations button . 5] Wireless/Network Driv... Ay Other App AirDrop

2. Touch and hold on the handle buttons ~ to
drag the destinations between the Available
column and the In-Use column. Items in the In-
Use column will appear in LumaFusion in the
order shown.

Figure 23-1 Adding and Organizing Library Destinations

3. Move the items up or down in the list to reorder. You can pick up multiple items by tapping and
holding on one item, and then tapping on an additional item with another finger.

4. Tap the back button in the upper left of the panel to exit.

Photos

Movies exported to the Photos App will show up under All Photos and Videos and also in the
Videos album. Once the export is complete you will see your movie appear in the LumaFusion
Photos Library.

YouTube, Vimeo and Weibo

Keep in mind that some social media sites will re-encode your media at a variety of qualities and will
playback the quality that best fits their platforms or the viewer’s connection speed.

Privacy settings such as Private, Public, Unlisted (YouTube) or Public, Private (Weibo), or
Anyone, Only people | follow, Only Me (Vimeo) can be set on the final export panel before
sharing.

On YouTube the description, Tags, and Category can also be set.
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Facebook

Exporting to Facebook requires that the Facebook App is installed on your device.

1. On the export destinations panel, select Other App/AirDrop

2. Choose your export settings and tap E> After the rendering is complete, the standard Share
Sheet will appear.

Note: If Facebook does not appear as an option, tap on the More button ... and turn on Facebook.

Box, Dropbox, Google Drive, Google Photos and One Drive

Movies exported to cloud storage providers can be placed in any folder, and if supported by the
destination, a new folder can be created at the time of export. LumaFusion can only write to your
cloud storage but cannot manage or delete files.

Frame.io - Uploading your Timeline and Receiving Comments

LumaFusion Projects with Frame.io comments can be exported to Frame.io as movies. Once the
movie is uploaded, replies to comments and new comments made in Frame.io will appear directly in
your LumaFusion timeline for that project.

1. Edit your project in LumaFusion.
2. Add Frame.io comments if desired.

3. Tap on Export, then select Movie, then choose Frame.io as your destination. You can choose a
folder or create a new one to export to.

Shorten this shot

4. Return to your Project Timeline and wait for
your collaborators to make comments on your
movie. When they do, you will see their
comments in the Navigator under the Preview.

Figure 23-2 Frame.io comment in a Timeline that was

5. You may reply to comments. previously uploaded to Frame.io

If you export again, only new comments will be
uploaded with the new version.

Note: LumaFusion can only write to your Frame.io folders but cannot delete files.
For more information about using Frame.io in LumaFusion, see:
Previewing and Commenting on Frame.io Source Media and

Using a Proxy Workflow with Frame.io, LumaFusion
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GNARBOX and WD Wireless Pro Drives

LumaFusion includes custom integrations to export to these wireless drives directly.

Wireless/Network Drives

If you have a wireless network drive connected that uses the SMB protocol, then you can export
directly to the drive.

When using Wireless / Network drives for the first time you will be asked to ‘Add a server’
1. At the prompt choose from the list of drives available on your current network.
2. Enter your user ID and Password.

After entering your credentials, you will be able to navigate to files and folders on your network drive.

Files

The Files destination will display the standard iOS file browser, allowing you to select a folder to
export the movie. This folder can be any storage shown on your iOS device, or an external drive if
you’re using iOS 13. You can even export directly to another app’s folder if the app supports file
sharing.

Other App/A”'D rop Tap to share with AirDrop

If you choose this option, the file will be written prior to

selecting the destination. Once the file is created, you'll
see a share sheet which displays AirDrop destinations

available as well as any apps on your device that can
accept the file type you have created. You can select O 8 &
multiple locations to share to before closing the share

Sheet Message Mail Add to Notes Shared Albums

To export via AirDrop both your edit device and the
destination device (such as other iOS devices or Mac “ @ = oo
desktop computers), must have Bluetooth turned ON.

Save Video Copy Save to Files More

Rendered Movies Folder Figure 23-2 Other App/AirDrop panel

If you select Rendered Movies as your destination, the file is added only to the LumaFusion
Rendered Movies folder. This is a great way to “mix down” a master without having to export it to
another app or destination.
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Export Settings

Recommended Settings & Last Destination Settings

At the top of the Movie Export dialog, choose whether you'd like to Change to Last Export Settings
for that destination, or Change to the Recommended Settings for that destination.

Resolution

The available resolutions are based on the project's aspect ratio, which is selected in the Help and
Settings panel.

Even though it is common to only use one number when talking about a video resolution such as
“1080p,” resolutions always have two numbers; 1080p is more accurately 1920x1080. The first
number refers to the width of the frame in pixels, and the second refers to how many lines a video
has from top to bottom.

The “p” after the resolution means that the lines of video are drawn progressively, or in sequence.
This is in contrast to interlaced video where only the odd lines, then the even lines of each frame are
drawn alternately, so that only half the number of actual image frames are used to produce video.
LumaFusion only produces progressive video resolutions.

If your original source media was shot at 1920x1080, and you choose to export full frame video at
4K (which is 3840x2160), then the pixels will be drawn twice as wide and twice as tall with no
increased quality.

On the other hand, you may want to shoot at 4K and export at 1920x1080, giving you the freedom to
zoom or crop into your clips up to 200% (or 4X) without losing quality.

For more information, see

Frame Rate
The export frame rate will be the same as you have set in the Project Settings. To change the frame

rate of your current Project, tap the Help and Settings button {?} and then tap on the Settings tab.

For more information, see

Video Quality

The Video Quality refers to the megabits per second (Mbps). To maximize quality, it is
recommended that you match the Mbps of your source video as closely as possible. Increasing the
quality setting beyond the Mbps of the original source clips will result in larger files with no additional
benefit. If your destination is a video sharing platform, you may wish to check their recommendations
for export bitrate.

Video quality values are based on the total resolution of the export (width x height), so they may be
different based on the aspect ratio and resolution selected (ie: 1920x1080 will have a higher bitrate
for Standard than 1920x724).
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The starred () quality recommendation is based on the highest-Mbps clip in the project. The
starred Video Quality will never go below “Economy”.

Audio Quality

LumaFusion can export your audio at 16kHz, 32kHz, 44.1kHz, or 48kHz. Choose the option required
by your destination.

Color Space

If the project is set to Standard - Rec. 709, the default color space in LumaFusion, then there will be
no Color Space options on export. However, if the project is set to one of the HDR options, then a
Color Space selector will be available in the Movie Settings export pop-up.

For more information, see Setting the Project Color Space

Video Codec

Choose either H.264, HEVC (H.265) or HEVC with Transparency for your export. Select the option
that is appropriate for your destination. H.264 is currently the most commonly supported codec, but
H.265 can provide a higher quality at the same bit rate. When exporting to HEVC with Transparency,
if there are portions of your project that do not fill the frame (showing black or your chosen
background color behind) then these black portions of your project will be exported as transparent
and can then be used to layer over another video.

Includes (Video/Audio)

LumaFusion can include Video and Audio, or Video Only on the exported video file. For audio only
exports you must choose the Audio Only option from the first export panel menu.
File Format

LumaFusion can export MPEG4 (.mp4) or QuickTime (.mov). Choose the option required by your
destination.

Creating and Exporting 360° VR

If you have 360° footage, and you have edited in LumaFusion with a 2:1 Project Aspect Ratio, then
you can choose 360° Mono, 360° Top-Bottom Stereo or 360° Left-Right Stereo instead of Normal
Video. LumaFusion will then inject the metadata providing the information to play your video in a
360° player.

Export Duration

Indicates the length of your exported project in Hours: Minutes: Seconds: Frames.
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Space Needed for Export (Estimated)

The space needed on your device for a successful export to any destination is normally about 2
times the size of your File Size. This is because a temporary file must be created on your device
before uploading the file, or sending it to another app. The temporary file will be deleted as soon as
the file is uploaded or sent.

File Size (Estimated)

The File size is the estimated size of the final file created by export.

Available Space

This shows the amount of space reported as remaining by your device.

Exporting a LumaFusion Project Package

LumaFusion Project Packages are a special zipped package (.Ifpackage) that contains used media
and the LumaFusion Timeline data including cuts, transitions, effects and levels, and any new
Frame.io comments since the last upload to Frame.io. The archive can then be restored on the
same or another device for continued editing. LumaFusion Project Packages are also a great way to
back up a project periodically or when you're finished editing.

LumaFusion Project Packages cannot be played outside of LumaFusion.

1. Tap on the Export button Q Then tap LumaFusion Project Package .

2. Log into the destination if necessary. This will only be required the first time you export to cloud
storage or a social network.

3. Navigate to the directory you want to export to (if necessary).
4. Choose the amount of media to include in your export:

Full Original Media includes the entire source clip for any clip used on the Timeline. If you used 1
frame of a 1-hour clip, this would include the 1-hour clip in the archive package.

Trimmed Media includes only the portions of media that were used on the Timeline, plus 1 - 2
seconds on either end to provide enough for fine trimming on the restored project.

5. Tap the Share button m

Tips and Tricks: If you want to switch devices or share your project with another person so they
can continue editing, you can quickly AirDrop a LumaFusion Project Package to another iOS
device and continue editing within minutes.

For more information, see Other App/AirDrop
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Export to XML Project Package for FCPX

This feature is an in-app purchase.

FCPXML export files are special zipped packages (.zip files) that contain the Timeline data and can
also contain the necessary media so that the project may be further edited on Final Cut Pro X on the
Mac.

It is not necessary to export the media from
LumaFusion along with the XML file if you are
planning to relink to your original media in Final
Cut Pro X. Eliminating media allows a smaller EERYIE

XML file to be transferred. But, in order for

relinking to work properly, both systems must il Audio Only

have access to information that identifies both the .

file and the specific frames within the file. This ) L Rsiion e ot e e
chapter will help guide your workflow to ensure a
successful transfer and successful relinking.

X Share / Export

'ﬁ;‘ XML Project Package

For information on relinkable media, see (0] Snapshot

If you are transferring media with your XML file,

the source clips used on your LumaFusion Figure 23-3 Project Color Setting in Help and Settings
Timeline will be transferred at their native

resolution and frame rate as part of the FCPXML Project Package and they will be automatically
present in your FCPX Timeline. Be sure to check your project’s video resolution in Final Cut Pro X
to avoid unnecessary rendering.

The frame rate of your LumaFusion project will be used as your Final Cut Pro X project’s frame rate.
Because Final Cut Pro X will not allow you to change the frame rate, it is important to set your
desired project frame rate in LumaFusion before export.

Because not every feature is designed exactly the same in each application, some LumaFusion
features will not be supported in FCPX

This chapter will help you understand what options to choose and what Timeline features are
supported.

For more information about supported FCPXML transfer features see

There is also a video tutorial that explains what to expect.

XML Export to Final Cut Pro X
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https://youtu.be/JHG2AA6kQYU

To Export to Final Cut Pro X

1. Tap on the Export button in LumaFusion m
Tap XML Project Package.
Log into the destination if necessary. This will only be required the first time.

Navigate to the directory you want to export to (if necessary).

o > 0 DN

Choose the amount of media to include in your export:

Full Original Media includes the entire source clip for any clip used on the Timeline. If you used
1 frame of a 1-hour clip, this would include the 1-hour clip in the archive package.

Trimmed Media includes only the portions of media that were used on the Timeline, plus 1 - 2
seconds on either end to provide enough for fine trimming on the restored project.

No Relinkable Media includes any media that cannot be successfully relinked in Final Cut Pro
X, but does not include media that should be able to be relinked to the Timeline once in Final
Cut Pro X.

For information on relinkable media, see \What Types of Media are Relinkable in FCPX?

6. Tap on the Export button again @

Be sure the FCPXML.zip file is located in the Downloads folder of your Mac to enable automatic
relinking when possible. If it is not located there, move the file to the Downloads folder.

2. Unzip the file by double-clicking on the .zip file.
3. In the unzipped folder, double-click on the project-name.fcpxml file.

4. This will open the project in Final Cut Pro X and import any media in the zip file.

If you have chosen “No Relinkable Media” then wherever possible, media will automatically be
relinked as long as the zip file was located in the Downloads folder of your Mac. If there are still
clips that have missing media in Final Cut Pro X, or you open the file from a location other than
the Downloads folder, then you can manually relink your FCPX Timeline clips to the original
clips.
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What Types of Media are Relinkable in FCPX?

If media is able to be relinked in FCPX, then it is not necessary to package that media with the
FCPXML file. You may still wish to include the media as a way of storing all the necessary elements
that make up a project, however this will result in a much larger file. The following table shows what

types of media are relinkable in FCPX:

Media in LumaFusion Libraries

Relinkable in FCPX?

Photos
Storyblocks
Titles
Music
GNARBOX
WD

Imported Media (using LumaFusion import)

No
No
No
No
Yes
Yes

Yes (unless mixed down to
Rendered Movies Folder)

SanDisk iXpand drive Yes
Dropbox, Google Drive, Box, OneDrive Yes
Files App / SSD Yes
Files App / SD card Yes
Wireless / Network SMB Yes
FiLMiC Non-timecoded media Yes
FiLMiC Timecoded media from FiLMiC V.7 and Yes
above.
LumaFusion Consolidated / Optimized Media No
Trimmed Media from Archived LumaFusion Projects = No
Rendered Movies Folder Media No

Media from Files App

SSD drive Yes

FiLMiC (Documents) Yes

SD card Yes

Media from Other Apps

Files manually copied to the LumaFusion User Media No

folder and files imported from Other Apps
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What Features Will Transfer from LumaFusion with FCPXML?

Some features do not have an equivalent in Final Cut Pro X and are currently not supported during
the XML transfer from LumaFusion to Final Cut Pro X. As LumaFusion increases its depth of
FCPXML translation, some unsupported features will become supported.

LumaFusion
Area

Timeline

Timeline Mixer
Timeline Track

Frame and Fit

Speed

Audio

Color and Effects

Feature

Multitrack Timeline with audio, photos, videos
Transitions

Video Cut / Audio Crossfade transition
Fade-in and out (at head and tail of Timeline)
Audio Track Mixer Levels and Mute
View, Lock, Mute and Markers

Mirror

90° Rotate

Fit Mode (Fit and Fill)

Fit Mode (Focus and Stretch)

Basic Cropping and Keyframes

Edge Softness and Corner Radius
Size / Position / Rotate and Keyframes
Blending (Opacity)

Blending (Blend Mode)

Speed Forward and Reverse

Maintain Audio Pitch

Titles

Audio Effects

Audio Configuration

Audio Levels and Keyframes

Audio Panning and Keyframes

Color Corrections and Effects

LUTs

Chroma Key

Supported in
FCPXML Transfer?

Yes
Yes
Yes* (See note)
Yes** (See note)
No
No
No
No
Yes
No
Yes
No
Yes
Yes
No
Yes
No
Yes*** (See note)
No
No
Yes
Yes
No
No
No

* The Video Cut-Audio Cross transition does not have an equivalent in FCPX, so the audio cross
fade is represented as a ramp in the audio waveform. This can be hard to see, unless you increase
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the height of the audio waveform. Alternatively, you can detach the audio tracks in FCPX, to see the
audio tracks overlap.

** Fade-in and fade-out transitions (cross dissolves against black) that are located in the middle of
the Timeline rather than at the head or tail of the Timeline do not have an equivalent in FCPX, so
those transitions will be replaced with black clips so that you can easily add crossfades in FCPX to
create the fades.

*** Titles are transferred as images only and are not editable in FCPX.

Exporting Audio Only

When exporting audio only, the audio options are expanded so that you can export at up to 96kHz,
and you can choose either Waveform Audio (.wav) or Apple M4A Audio (.m4a).

1. Tap on the Export button ﬁ
2. Tap on Audio Only """h‘.

3. Select a destination.

4. Tap the Export button @

Creating a Snapshot Image

At any time while editing, if you see a frame in the Preview that you want to capture as a still image,
then you can create the still with the Snapshot feature.

e Tap on the Export button m

=
e Tap on Snapshot I@l

Your full resolution snapshot will be stored in the Photos app under All Photos.

Tips and Tricks: In Help and Settings > Preferences you can change the format used for storing
snapshot images. Choose PNG or JPEG depending on your needs.
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24. Help and Settings

Settings

Tap the Help and Settings button {?:? .

¢ In the Settings tab you will find important settings for your current Project. You can also find
clip defaults that determine how clips behave when they are added to the Timeline.

¢ In the Ducking tab, you will find the settings for Audio Ducking in your current project.

¢ Inthe Preferences tab you will find New Project defaults, Frame.io defaults, and User
Interface defaults.

e The Cleanup tab, offers a variety of choices for removing cached media and temp files that
are no longer used.

e The Help tab is the place to go to access Tutorials, Reference Guides and Support

Current Project Settings

Current Project Settings affect the Project that is currently open on your Timeline.

Frame Rate

Sets the Frame Rate for your currently open project. This can be modified at the start of the project
or later in the Project Settings.

For more information, see: Setting the Project Frame Rate

Frame Aspect

Sets the aspect ratio for your currently open project. This can be modified at the start of the project
or later, in the Settings tab.

For more information, see: Choosing the Project Frame Aspect Ratio

Color Space

Sets the Color Space for the current project. This can be modified at the start of the project or later,
in the Settings tab.

For more information, see: Setting the Project Color Space
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Background Color
The background color of your project can be changed from black to any color.

When a Background Color is set, any transparent portions (including fade in and out) of your movie
will show through to the color you chose rather than black. This is an important feature for
embedding video into websites that have background color.

For information on using the color picker, see: Using the Color Picker

Clip Defaults

Fit Mode

Sets the default Fit Mode for clips that have aspect ratios that do not match the project aspect ratio.
This setting does not affect existing Fit Modes for clips already on the Timeline. The Fit Mode can be
modified per clip by opening the Frame and Fit Editor.

Photo / Title / Transition

Sets the default length for new photos, titles, and transitions when they are first added to the
Timeline. These settings do not affect existing durations for items already on the Timeline. Durations
can be modified once the clip, title or transition is on the Timeline.

Ducking

Adjust the Audio Ducking settings for the currently open Timeline.

For information on using Audio Ducking, see Audio Ducking

Preferences

The Preferences tab is where you can set defaults for LumaFusion. For example, if you always
create projects with a 16:9 Frame Aspect ratio at 30fps then setting those values in the Preferences
will create every new project with those settings, avoiding both repetition and potential mistakes.

New Project Defaults

Frame Rate

Sets the default Frame Rate for future projects. This can be modified at the start of the project or
later in the Project Settings and can also be set upon export.

For more information, see: Setting the Project Frame Rate
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Sets the default aspect ratio for future projects. This can be modified at the start of the project or
later, in the Settings tab.

Frame Aspect

For more information, see: Choosing the Project Frame Aspect Ratio

Color Space

Sets the Color Space for future projects. This can be modified at the start of the project or later in the
Project Settings.

For more information, see: Setting the Project Color Space

Adjust Based on First Video Clip

When this setting is ON, the Frame Rate, Frame Aspect and Color Space are determined by the
details of the first video clip added to your project. These settings can be changed on your current
project at any time in Help and Settings > Settings > Current Project Settings. When this setting is
OFF the New Project Defaults will be used at the start of every project regardless of the details of
the first clip dropped on the Timeline.

Number of Project Backups to Keep

Multiple backups of your project are saved automatically (data only, no media). You can find the
backups in the Files App under On My iPad (or On My iPhone) > LumaFusion > Project-Backups. To
open a backup, tap on it in the Files App and it will open in LumaFusion, with an appended number
after the name.

Frame.io

Frame.io

When using Frame.io media that is not supported by iOS, Frame.io will create proxies so that you
can proceed to edit with LumaFusion. The Frame.io Download setting allows you to select the
resolution of the proxy files.

For more information, see: Using a Proxy Workflow with Frame.io, LumaFusion and FCPX
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User Interface

Clip Style

Clip Style allows you to change the way your Timeline looks by simplifying what is displayed on the
clip faces.

Choose between Normal, No Icon (which hides the thumbnail on video clips on the Timeline), and
No Waveform, (which hides the audio waveform on clips with audio on the Timeline).

Show Touches

Show touches displays a blue dot on the interface wherever your finger touches the screen. This is
useful for trainers displaying the app to an audience on a separate monitor or in a screen capture.

Reverse Frame Step Gestures

Swiping left and right on the Preview moves forward or backward one frame at a time. By default,
this action follows the logic of turning the pages of a book or moving film over a play head. If you
prefer the gesture to be reversed, you can change this behavior here.

Seek to Selected Clip

Sets the Timeline’s behavior upon selecting a clip. In the default ON position (blue), selecting a clip
will snap to place the Play Head at the head or tail of that clip. When toggled off, selecting a clip will
not affect the Play Head’s position on the Timeline.

Keyboard Shortcuts Layout

LumaFusion automatically detects the language of any connected hardware keyboard. If you prefer
to use a keyboard shortcut layout other than the default for your connected keyboard, this setting
enables you to manually select any of the 15 languages for which Apple makes keyboards.

Advanced Settings

Preview

Sets the quality of image displayed in the Preview window inside LumaFusion. On some slower
devices, or when editing with multiple tracks, it may be necessary to lower the Preview Quality to
Fastest, This allows smooth playback performance and helps avoid running out of memory on your
device, which can cause instability. If you set the Preview to Fastest, you will notice the quality of
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the Preview looks lower. However, this setting does not affect your final output quality (which is
controlled by your export settings at the time of export).

e Choose from Fastest, Balanced, Good or Best.

Ripple Main Track for Transition Insert

If this setting is turned ON LumaFusion will make sure there is enough media to play through the
entire transition by shortening your Timeline clips if necessary when a transition is added.
LumaFusion will only shorten Timeline clips under the following circumstances:

¢ If the transition is being added between video clips and one or both of them do not have enough
media to play through the transition (photo clips always have enough).

¢ [f you have Ripple Main Track for Transition Insert turned ON.
e [fyou are in Insert Mode =>| on the Timeline

If Ripple Main Track for Transition Insert is turned OFF and there is not enough media from either
of the clips, you will see an A and/or B indicator on the transition to indicate that there is not enough
media from the A or B clip, and if you select the transition, a warning will appear above the transition,
“Clip before/after transition needs to be trimmed to play through entire transition.” You can
either trim the tail of clip A and the head of clip B to provide enough media (you will see a blue
highlight during trimming to help you see how much should be trimmed) or you can ignore this
warning. If you ignore the warning the video from the clip lacking media clip will freeze for part of the
transition.

Unlink Track When Locked

For more information on linking, see Track Header

Snapshot Images
Choose whether snapshot images are created as PNG or JPEG files.

For information on creating snapshots, see

Prefer Alternate Export

Internally there are two ways of exporting movies. The Standard Export method considers the
entire Timeline and attempts to export only after a full calculation of all of the layers and edits from
the start of the Timeline to the end. This means that if there is a problem in just one spot, the export
is abandoned with no second tries.

A second, Alternative Export method considers smaller sections of the Timeline allowing
LumaFusion to try several times on a failed section to make a successful single file. This method,
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while perhaps more robust, may take longer and while unlikely, could allow accuracy errors to be
introduced. However, in some cases having this more robust method will allow an export, where the
standard method would not have worked.

e Turn ON Prefer Alternate Export to always try the Alternate Export method first.
e Turn OFF Prefer Alternate Export to always try the Standard Export Method first.

If you have a project that fails to export, you will be presented with an export error that provides four
options to resolve the issue:

e Tap on Info to learn more about common exporting problems and solutions.

e Tap on Use Alternate Export Method or Use Standard Export Method to try your export again
using the export method that wasn’t already tried.

e Tap on Optimize Project to assure that your media is optimized to export using iOS.
For information on Optimizing, see Optimize and Consolidate Project

e Tap on Cancel to abandon this export and use the information presented in the error message
about the location of the error in your Timeline to try to fix the problem on your own.

Cleanup

The Cleanup menu allows you to remove cached media from your device to free up storage space.

Cleanup Temporary Files
Temporary Files include media that was created for temporary renders (mainly of reverse motion,
since there are no other situations where LumaFusion creates a temporary render).

7
1. Tap the Broom button to immediately cleanup the Temporary Files.

Cleanup Unused Cached Media

Unused Cached Media includes media imported from the Photos App or external drives like
GNARBOX and WD, or media downloaded from Storyblocks that is NOT used in any LumaFusion
project.

1. Tap Cleanup Unused Cached Media.
2. Choose the types of media you would like to cleanup by toggling their switches.

4
3. Tap the Broom button to immediately cleanup unused media originating from the selected
locations.
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Cleanup All Cached Media

All Cached Media includes media imported from the Photos App or external drives like GNARBOX
and WD, or downloaded from Storyblocks, EVEN if it is used in a project.

Note: If you cleanup cached media that is used in a project, when the project is opened LumaFusion
will attempt to find the media in its original location and redownload the media in order to allow the
project to play. If the required media is not available for LumaFusion to automatically download, then
it will appear as missing in your project.

1. Tap Cleanup All Cached Media.

2. Choose the types of media you would like to cleanup.

3. Tap the Broom button to immediately cleanup all media from the selected file types.

For more information about missing media, see Relinking and Replacing Missing Media

Automatic Cache Cleanup Settings

Whenever a project is deleted, or a clip is removed from the Timeline, media types set to ON in the
Automatic Cache Cleanup Settings will be reviewed and compared against media used in any
existing project. At this time, media from selected sources that is NOT used in any LumaFusion
project is removed from the app. Selected media sources can include Photos App media, media
from external drives like GNARBOX and WD, or media downloaded from Storyblocks. This is a good
way to make sure your media does not take up too much room on the device.

1. Tap Automatic Cache Cleanup Settings.

2. Choose the types of media you would like to auto-cleanup the next time you delete a project or
remove a clip from the Timeline.

Files Info

The Imported Media and In-Use Reversed Media sizes are provided to help understand how much
space you can save by removing this media.

For more on about removing imported media, see Delete Imported Clips
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Help

We take support seriously and our dedicated team is happy to help!

Press and hold the Help and Settings button '{:?} to display Tooltips or tap on the Help and Settings
button and then go to the Help tab for options.

Tutorial Videos

Free basic and advanced level tutorials are available at https://luma-touch.com/Iftutorials and are
also available from within the LumaFusion App. (internet connection required).

Reference Guide

This reference guide is available on-line at https://luma-touch.com/Ifguide and is also available from
within the LumaFusion App. (internet connection required).

Also, find answers to questions in the LumaFusion knowledge base at htips:/luma-
touch.helpscoutdocs.com, or email us at support@luma-touch.com

Upload Project to Support

If you are experiencing difficulties with a particular project, we are here to help solve the problem
and get your project finished. Occasionally the best way for us to understand the problem is to see it
firsthand.

If you encounter a problem while working in LumaFusion, email us at support@|uma-touch.com and
describe the problem. We will send you a code that will allow you to upload your project to us with a
single tap. We will be notified once your upload is complete and then our support team will respond
to your original mail. Your project and media will only be seen by our support staff and will only be
used to help us solve the problem you are experiencing. After the problem is solved, your project
and media will be removed from our private server.

Review LumaFusion

We are a small team dedicated to making the best multitrack professional editor for mobile. Our
success depends on the support of customers like you. If you are happy with our product, we would
very much appreciate it if you would take a moment to rate and review the app in the App Store.

If you encounter a problem with the app, please email us at support@luma-touch.com, and give us
the opportunity to help make your project a success.
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25. Gestures Table

Library

Tap the multi-select button then swipe your
finger diagonally over the clips to multi-
select

To multi-select clips

Pull down with your finger

To Refresh the Library

Swipe up twice from the bottom of the
screen

To leave the app

Project Manager

Slide your finger along the filmstrip

To quickly scrub through the selected project

Double tap on a Project

To open the Project

Preview

Single Tap in the Preview window

To play or pause the preview

Swipe down in the Preview window

To mark an In point

Swipe up in the Preview window

To mark an Out point

Double Tap in the Preview window

To grow the Preview to full screen. Double tap
again to return to normal view.

Swipe Left in the Preview window

To step forward one frame This gesture can be
reversed in Settings > Preferences

Swipe Right in the Preview window

To step backward one frame This gesture can be
reversed in Settings > Preferences

Press, Hold and Drag the image in the
Preview window

To drag the marked portion to the Timeline

Press and Hold the Play button

To open the incremental scrubber to move slowly
or quickly through your media
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Double Tap the Play button

To begin looped play between the In point and the
Out point of a source clip or the start and end of
the Timeline

Press-and-hold the Jump buttons

To single-step slowly backward or forward

Double tap the Jump buttons

To quickly jump to the head or tail of the Timeline

Two-Finger Swipe Left

To select the next item in the library to preview (if
there is a single item selected in the preview)
This gesture can be reversed in Settings >
Preferences

Two-Finger Swipe Right

To select the previous item in the library to preview
This gesture can be reversed in Settings >
Preferences

Timeline

Pinch the gray area of the Timeline

To zoom in and out on the Timeline

Triple Tap To zoom into single frames — Triple tap again to
go back to your last zoom level. When zoomed in,
the blue play head will turn white indicating that it
is showing the start-to-end of a single frame.

Double Tap To see your full Timeline — Double tap again to

zoom back to your last zoom level

Frame and Fit Editor

Twist the frame using two fingers

To rotate the image

Drag with one finger

To move the frame

Drag the blue handles on the sides of the
blue frame

To reshape the frame

Drag the blue handles on the corners of the
blue frame

To resize the frame
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Pinch with two fingers To resize the frame

With the Crop control group open:

Drag the blue handles around the edge of | To Crop the frame
the yellow frame.

Drag with one finger To Move the cropped area

All Effects Editors and Titler

Press and hold the small arrows to either To adjust the slider incrementally allowing more
side of any slider exact positioning of the slider
Press and hold the Play button To open the incremental scrubber to move slowly

through your media.

Double Tap the Play button To Start Loop Play (tap to exit looping)
Drag the Green dot on effect overlay To adjust the amount and angle of an effect
controls

Drag the Blue dot on effect overlay controls | To adjust the position of an effect
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26. Keyboard Shortcuts Table

LumaFusion automatically detects the language of any connected hardware keyboard. If you are on
an iPad, press and hold the Command (Cmd) key to get a list of keyboard shortcuts. There are
multiple pages of shortcuts; swipe left and right to see them all.

If you are on an iPhone the list does not appear when pressing the Cmd key but the shortcuts work
with a compatible external keyboard.

We have also partnered with Editors Keys to create a sleek
silicone keyboard overlay for your iPad’s keyboard:

Magic Keyboard http://lumatouch.co/editors-keys-magic-case

Smart Keyboard Folio http://lumatouch.co/editors-keys-smart-
cover.

Order one now and never forget a shortcut!

LumaFusion supports keyboard shortcuts for 14 international keyboards (Arabic, Chinese
(Simplified), Danish, English UK, English US, French, German, Italian, Japanese, Korean,
Portuguese EU, Russian, Spanish EU and Taiwanese (Traditional Chinese)). LumaFusion
standardizes the shortcuts as much as possible given that some keyboards have slightly different
layouts.

The following pages show a list of keyboard shortcuts for both iPad and iPhone.
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Timeline

Cmd-B Split clips (splits single clip if selected, otherwise all clips at current time)
Delete Delete selected clip

Cmd = Zoom In

Cmd - Zoom Out

C Select clip at play head (cycles through clips with multiple presses)
M Add / Remove Timeline Marker

Option / Toggle between Insert and Overwrite Mode

V Add Voiceover

T Add Transition

Y Add Overlay Title

u Add Main Title

R Add Blank Clip (only on main track, when in Insert mode)

Cmd Z Undo

Cmd Shift Z Redo

Clip Selected on the Timeline

Option [ Trim start of clip to position
Option ] Trim end of clip to position
0 Show Clip Info

Option S Slip Trim (toggles on/off)
CmdC Copy selected clip(s)
CmdV Paste selected clip(s)
CmdD Duplicate Clip

o
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Option D Detach Audio

Option ; Link/Unlink

Option P Show presets

Option A Attributes clipboard

Option N Clear clipboard

~ Open Clip Editor / Close Clip Editor

1 Open Frame and Fit Editor

2 Open Speed Editor

3 Open Title Editor (only available when a Title clip is selected on the
Timeline)

4 Open Audio Editor

5 Open Color and Effects Editor
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Previewing Source or Timeline

Space Play/Pause

\ Play from Start

Up Arrow Jump to previous cut
Down Arrow Jump to next cut

Left Arrow Step one frame backward
Right Arrow Step one frame forward

Shift-Left Arrow

Step 10 frames backward

Shift-Right Arrow

Step 10 frames forward

Shift [ Jump to start

Shift ] Jump to end

A Jump to start

S Jump to end

J Play Reverse (not available on Timeline)

K Stop playback

L Play forward (press again to play 2x speed)
Option K Loop Play

= Toggle Full Screen Preview

F Add Frame.io Comment
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Source Clips

Tap on a Library source clip

M Add Marker to Source

I Mark In at current frame

@) Mark Out at current frame
Shift | Reset In point

Shift O Reset Out point

Shift U Reset both In and Out points
w Insert to Main Track

0 Show Info view

Inside the Clip Editors

~ Close Clip Editor (return to Timeline)

Thank you for using LumaFusion and reading this guide.

We are a small team dedicated to making the best multitrack professional editor for mobile. Our
success depends on the support of customers like you. If you are happy with our product, we would
very much appreciate it if you would take a moment to rate and review the app.

If you encounter a problem with the app, please email us at support@luma-touch.com, and give us
the opportunity to help make your project a success.

¢é: Lumalouch



mailto:support@luma-touch.com

	1. Using this Guide
	2. What’s New in the V2.4 Reference Guide
	3. Getting Started
	Creating a New Project
	Setting the Project Frame Rate
	Choosing the Project Frame Aspect Ratio
	Setting the Project Color Space

	4. Managing Projects
	The Project List
	Project Filmstrip
	Add a Project
	Color Tag a Project
	Rename a Project
	Add Notes to a Project
	Duplicate Project
	Search Project Info
	Sort Projects
	Delete Project
	Archiving, Restoring and Consolidating
	Optimize and Consolidate Project
	Export (Archive) LumaFusion Project Package
	Import (Unarchive) a LumaFusion Project Package
	Automatic Project Data Backup


	5. The Media Library
	Library Sources
	Add/Edit Library Sources
	Photos
	Optimize iOS iPad/iPhone Storage

	Storyblocks
	Titles
	Transitions
	Music
	Frame.io
	Imported
	Files
	GNARBOX
	Western Digital WD My Passport Wireless Pro, SSD and MyCloud

	Adding Clips to the Timeline
	Multi-Select Library Clips
	Timeline Warnings

	Finding Your Media
	Library Breadcrumb
	View and Sort
	Search
	Color Tag Clip


	6. Storyblocks for LumaFusion
	Content of Storyblocks for LumaFusion
	Storyblocks for LumaFusion Subscription
	How to Cancel Your Storyblocks Subscription
	Using Tags and Search with Storyblocks
	View and Sort Options for Storyblocks
	Talent, Property and Editorial Use


	7. Import
	Importing Media
	Import Sources
	Add/Edit Import Sources
	Files App and USB-C Connected Drives
	SMB Network Attached Storage Drives
	SanDisk iXpand Flash Drives
	‘Share to’
	Import Content in Zip Files

	Managing Your Media
	Used Media Indicator
	Delete Imported Clips
	Where Photos App Media is Stored During Use
	Adding (and Removing) Media using a Desktop Application
	Relinking and Replacing Missing Media


	8. The Preview
	Transport Controls
	Jump Backward
	Jump Forward
	Play/Pause/Loop Play
	Incremental Scrubber
	Timeline Navigator

	Preview Timecodes
	Current Time
	Duration

	Pre-Trimming Clips
	Preview Gestures
	Markers
	Using an External Monitor
	Connecting an External Monitor with an HDMI cable
	Connecting an External Monitor with Apple AirPlay

	Frame.io
	Previewing and Commenting on Frame.io Source Media
	Using a Proxy Workflow with Frame.io, LumaFusion and FCPX


	9. Information Panel
	Rename Clips or Projects
	Add Notes
	Color Tag Timeline Clips
	Finding the Projects Where a Clip is Used

	10. Editing Basics
	The Main Track
	The Ruler
	The Play Head
	Adding Clips
	Removing Clips
	Moving Clips
	Split Clip(s)
	Undo/Redo
	Clone Clip

	11. Critical Editing Concepts
	Edit Modes
	Insert / Ripple Delete Mode
	Overwrite Mode
	Replace Mode

	Clip Linking
	Unlinking and Relinking a Clip or Clips
	Unlinking All Clips on a Track

	Timeline Multiselect
	Deselecting from a Multiselect
	Multiselect Functions

	Clipboard
	Cut / Copy / Paste Clips
	To Copy/Paste Effect Attributes

	Track Header
	Lock Track
	View Track
	Mute Track


	12. Trimming Clips
	Timeline Trimming
	Slip Trim
	J-Cut and L-Cut
	Audio Priority J or L-Cut
	Video Priority J or L-Cut


	13. Transitions
	Adding Transitions
	Positioning Transitions
	Start at Cut (Fade In)
	End at Cut (Fade Out)
	Centered (Dissolve or Crossfade)

	Trimming and Setting Durations of Transitions
	Setting the Default Transition Duration
	Assuring Media is Available for a Transition


	14. Timeline Toolbar
	Project Manager
	Track Header
	Audio Mixer
	Clone Clip
	Detach Audio from Clip
	Link/Unlink
	Edit Clip
	Presets
	Clipboard
	Timeline Multiselect
	Split Clip(s)
	Add Clip
	Trash
	Layouts
	Export Project
	Help and Settings

	15. Audio Mixer
	Level Meters

	16. Voiceover Recording
	17. Clip Editor Basics
	Opening and Closing the Clip Editors
	Clip Editor Preview
	Solo and Hide
	Filmstrip / Scrubber
	Timecodes
	Jump Back / Forward
	Step Back / Step Forward
	Play/Pause/Loop Play

	Effect Presets
	Saving and Recalling Presets
	Sharing, Renaming and Deleting Presets

	Control Group Stack
	Creating Keyframe Animations
	To Add Keyframes
	To Modify Keyframes
	To remove a single keyframe:
	To remove ALL keyframes for a Control Group:

	Undo/Redo
	Exiting a Clip Editor

	18. Audio Editor
	Audio Channel Configuration
	Audio Ducking
	Volume
	To adjust the overall clip volume:
	To vary the volume over the length of your clip:

	Panning
	To adjust the overall clip panning:
	To vary the panning over the length of your clip:

	Audio Filters
	To add a filter:
	To remove a filter:

	Monitoring Controls
	Solo
	Mute


	19. Frame and Fit Editor
	Opening the Frame and Fit Editor
	Frame and Fit Tools
	Flip
	Rotate
	Reset
	Fit Mode
	Crop, Corner Radius, Soft Edge and Invert
	Size and Position
	Blending


	20. Speed Editor
	Fast and Slow Motion
	Reverse
	Maintain Audio Pitch
	Using High Frame Rate Clips for Smooth Slow Motion

	21. Color and Effects Editor
	Applying Color and Effects
	Color
	Levels
	Brightness
	Contrast
	Saturation
	Vibrance
	Highlight/Shadow Radius
	Highlight Amount
	Shadow Amount
	Color Temperature - Red / Green / Blue
	Gamma
	Hue
	Tint
	Using the Color Picker

	Color LUTS (Look Up Tables)
	Applying a LUT
	Importing a LUT
	Deleting a LUT

	Styles, Blurs, and Distort Effects
	Styles
	Blurs and Sharpens
	Distort Effects

	Chroma Key and Luma Key
	Applying Chroma Key Effects
	Applying Luma Key Effects
	Applying Color with Keys
	Show Mask

	Filling Text with Video Using Chroma Key
	Steps for Filling Text or Graphic

	Layer Controls
	Reordering Color, Effects and Keys
	Turning Effect Visibility ON/OFF
	Deleting an Effect


	22. Title Editor
	Adding a Title to the Timeline
	Opening the Title Editor
	Selecting a Title Layer in the Titler
	Add a Text, Shape, or Image Layer
	Editing Text
	Quick Editing Text in the Preview
	Pasting Text from a Nearby Mac Desktop
	Duplicate Layer
	Turn Layer Visibility ON/OFF
	Changing Layer Order
	Deleting a Layer

	Text Layer Settings
	Overall Layer Opacity
	Font
	Font Size
	Layer Justification
	Line Spacing
	Face, Edge, and Shadow Color
	Face, Edge, and Shadow Opacity
	Edge Width
	Shadow Angle
	Shadow Distance
	Shadow Blur

	Saving and Recalling Presets
	Style Presets
	Title Presets

	Importing/Loading Fonts
	Font Share to
	Import Fonts from Cloud Storage
	Import Font Packages Using the Files App


	23. Export and Sharing
	Exporting a Finished Movie
	Export Destinations
	Add/Edit Export Destinations
	Photos
	YouTube, Vimeo and Weibo
	Facebook
	Box, Dropbox, Google Drive, Google Photos and One Drive
	Frame.io - Uploading your Timeline and Receiving Comments
	GNARBOX and WD Wireless Pro Drives
	Wireless/Network Drives
	Files
	Other App/AirDrop
	Rendered Movies Folder

	Export Settings
	Recommended Settings & Last Destination Settings
	Resolution
	Frame Rate
	Video Quality
	Audio Quality
	Color Space
	Video Codec
	Includes (Video/Audio)
	File Format
	Creating and Exporting 360  VR
	Export Duration
	Space Needed for Export (Estimated)
	File Size (Estimated)
	Available Space

	Exporting a LumaFusion Project Package
	Export to XML Project Package for FCPX
	To Export to Final Cut Pro X
	What Types of Media are Relinkable in FCPX?
	What Features Will Transfer from LumaFusion with FCPXML?

	Exporting Audio Only
	Creating a Snapshot Image

	24. Help and Settings
	Settings
	Current Project Settings
	Frame Rate
	Frame Aspect
	Color Space
	Background Color

	Clip Defaults
	Fit Mode
	Photo / Title / Transition


	Ducking
	Preferences
	New Project Defaults
	Frame Rate
	Frame Aspect
	Color Space
	Adjust Based on First Video Clip
	Number of Project Backups to Keep

	Frame.io
	Frame.io

	User Interface
	Clip Style
	Show Touches
	Reverse Frame Step Gestures
	Seek to Selected Clip
	Keyboard Shortcuts Layout

	Advanced Settings
	Preview
	Ripple Main Track for Transition Insert
	Unlink Track When Locked
	Snapshot Images
	Prefer Alternate Export


	Cleanup
	Cleanup Temporary Files
	Cleanup Unused Cached Media
	Cleanup All Cached Media
	Automatic Cache Cleanup Settings
	Files Info

	Help
	Tutorial Videos
	Reference Guide
	Upload Project to Support
	Review LumaFusion


	25. Gestures Table
	Library
	Project Manager
	Preview
	Timeline
	Frame and Fit Editor
	All Effects Editors and Titler

	26. Keyboard Shortcuts Table
	Timeline
	Clip Selected on the Timeline
	Previewing Source or Timeline
	Source Clips
	Inside the Clip Editors


